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Copyright

Copyright 2018 by BenQ Corporation. All rights reserved. No part of this publication may be
reproduced, transmitted, transcribed, stored in a retrieval system or translated into any language or
computer language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical,
manual or otherwise, without the prior written permission of BenQ Corporation.

All other logos, products, or company names mentioned in this manual may be the registered
trademarks or copyrights of their respective companies, and are used for informational purposes
only.

Disclaimer

BenQ Corporation makes no representations or warranties, either expressed or implied, with
respect to the contents hereof and specifically disclaims any warranties, merchantability or fitness for
any particular purpose. Further;, BenQ Corporation reserves the right to revise this publication and
to make changes from time to time in the contents hereof without obligation of BenQ Corporation
to notify any person of such revision or changes.

This user manual aims to provide the most updated and accurate information to customers, and thus
all contents may be modified from time to time without prior notice. Please visit http://business-
display.beng.com/ for the latest version of this manual.
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BenQ X-Sign 2.0

Created to help users of BenQ interactive flat panels and digital signages to better utilize their
equipment, BenQ X-Sign includes BenQ X-Sign Designer for content creation and standalone mode
schedule setting. BenQ X-Sign also includes BenQ X-Sign Manager and BenQ X-Sign Player for cloud-
based content management and distribution, to show X-Sign Player in single or group displays.

Basic

How to register an account for X-Sign Manager

With BenQ IAM (ldentify and Access Management), you can manage all of your BenQ services
(including X-Sign Manager) in one account. Follow the steps below to register an account and
connect to X-Sign Manager.

We highly recommend you use the administrator of organization to register a new account for manager users and
devices.

I. Go to BenQ Service website: https://service-portalstage.benq.com/BenQIAM/public/login. Sug-
gested browsers are Chrome, Firefox.

2. If you are an administrator, click Sign up to register an Administrator account for the company.
If you are a regular user, ask your company’s administrator to create a user account for you.
After you receive the account, click Log in directly after verifying your email.

Welcome to BenQ Service

Login to start using IAM

Account ID or Email

Password

: Remember me Forget ID / password?

Resend verification email

Submit

4 BenQ X-Sign 2.0


https://service-portalstage.benq.com/BenQIAM/public/login

3. After you click Sign up, you will see the following message. As an administrator, click
Continue.

Message

Notice: If you are an administrator in your company, press "Continue” to sign
up an "Administrator Account" for your company. If not, please ask your
company's administrator to create a user account for you and login in directly

after verifying your email.

4. Fill in the following fields and click Submit to create a new Administrator account.

Sign up

* For the account ID, enter a value between 4 and 20 characters long. Only numbers (0-9), upper and lowercase
o alphabets (A-Z, a-z), and the following special characters (-)(.)(_) are allowed in the account ID and name.

* The password must be a combination of alphanumeric and must be between 6-12 characters. Passwords like
“2945678” (all numbers), “eduabsc” (all alphabets), “12ab” (less than 6 characters), and “|2abcd345678efg”
(more than 12 characters) are unacceptable.

» Uppercase and lowercase letters don’t need to be typed the same way every time you key in the password.

BenQ X-Sign 2.0 5



How to access your account

I. Go to BenQ Service website: https://service-portalstage.benq.com/BenQIAM/public/login. Log in
and choose X-Sign.

Welcome to BenQ Service

Login to start using IAM

D | GECTED

Account ID or Email

Password

["] rRemember me Forget ID / password?

Resend verification email

( Submit

H Bent Service Portal

Your Service

’ 1AM )' X-Sign \ AMS
' AM integrates the acoownt i~ Easy Conlent Creation r 4 To enforce privacy prolection

managements in all of the Schedulng, Managemsant While 2NSUTING COMVENence

We provide

E C
—_—
o
LY
&
’ 4 4 A
( p 8 -
1AM X-Sign AMS
1AM infegfates e account Managements in i Easy Content Crealion, Schaduling, = To enforce pivacy pridecbon while ensuing =

of the Ban(} Business Services. You can usa Management softwara|X-5ign Intuitive . Ban() IFPs feature Account

ong account 1o login a of the BenQ Busness Solution to Crate Wondious Signage Managemant System (AMS) for mult
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https://service-portalstage.benq.com/BenQIAM/public/login

2. Click Login to go to the X-Sign Manager page.

i X-Sign

u

Content Design and Management Made Easier than Ever

Features FAQs Downloads ContactUs @ Login

Why X-Sign?

S i S

¢ Content Creation Easy Content Scheduling Easy Content Mana,

)0 easy-to-use templates that Remotely schedule content distribution for single or  Use one or multiple accounts to ¢

a2 Account Management & Albert

Device Management o
~ Device
€
I Device Management
add category Device Updates Bearch
Channel Management + B Device Management
» Mar t
FieManagaricat Status ¥ Name Channel name Display ID
* My Favorite -
demorocmuwriter Unsubscribed 8MVRSPHZ
*  Report Analysis - = |
+  Advanced Application - e
Storefront_01 Unsubscribed 2UBSTNAP
* License Management Il - |
About 5 Demo Room
1 Asia
0 BQE
0 5
0 1F
0 2F
0 Europe
0 Aexico
0 Taiwar

BenQ X-Sign 2.0



How to set the permission for users

I. To set the permission for users, log in and choose IAM.

Your Service

g am )" X-Sign AMS
. AM integrates the account ‘- Easy Content Craation r 4 To anforce privacy protection
managements in &1 of the Scheduling, Management while ensuring convenience
We provide
— =
—_—
&
L
&
: x) ¢ A\
i . -
1AM X-Sign AMS
1AM integrates the accoun! managements n all Easy Content Creation, Schaduling - To enforce privacy protection while ensunng =
of the Ben(y Business Services. You can use Management soffware|X-Sign Infulive I | comenignce, Bang IFPS fealure Account

2. Select Role Management > X-Sign, then choose the account you want to set the permission
to. Click g% to continue.

n BenQ Identity and Access Management & Albert [

Account Management | Role Management | Agent Setting Service { Taiwa

X | A\

X-Sign AMS

o[+ -

Role &
1 - adcde
2 & Admin
3 & administrator(Defaul)
a - channel_manager({Default)
5 - content_manager(Default)
6. a faqvideo

8 BenQ X-Sign 2.0



3. You can set the permission to the account by checking the boxes. Click Submit to proceed.

Edit role settings
Role Mame adcde
Permission Device Management

Wiew

MNew

Edit

View Interrupt

Edit Interrupt

Remote control

Delete

Manager Report
Interactive click statistics

QR code

Channel Management
View
New
Edit channel
View channel schedule
Edit channel schedule
Instant message

Delete

Advanced Applications
Queuing system

APl Widget

BDP File Management
View
Upload
Edit
Delete

Approve

Submit Cancel

BenQ X-Sign 2.0
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How to purchase the license from X-Sign Manager

You can purchase the license from X-Sign Manager in License Management.
Avaiable space - 99.4 GB 22 Account Management 8 Albert Kang @ Language

Device Management ]

» Device

Elle Management Add a new display add category Device Updates Search...

» B% Device Management

> My Favour
; Status Name Channel name Display ID
» o ORRAM
*  Advanced Application B Queue Sys DemoRoom WMPWOYO9
* License Management
SRR AlbertPC Unsubscribed G3XNZLKA
Buy New License
History and Setting
B ABC123 Unsubscribed 4SPNANEF
About
B SL490 easytogo 4321 EMMHRFBT
4 m Category B
0 m Category A

bena. /index

Buy License Code

Please Choose Categories : O]

Buy New License Extend My Contract

Buy License Code
Buy New License ((:j
Solution 1 Year

Content  » Total storage up to 100GB.

Price USD 69.00

A

Quantity ‘ 1 . ”

[_More than 20 |

D
@ I Add to Shopping Cart BJ)

Buy License Code

Shopping Items (1) =
Buy New License
Content Price Quantity Summary
1 Year USD 69.00 1 . USh@l Cancel

Total Price : USIZ.

)

E), M | agree following items. Agreement ltems
3] —)

E_J 3) Checkout

After clicking Buy New License,

A. Choose the quantity of license which you want to purchase.
B. Select Add to Shopping Cart.
C. Click the shopping cart icon to access to the checkout page.

D. If the quantity is more than 20, it is highly suggested that you select More than 20.

10 BenQ X-Sign 2.0



E. After reading the agreement terms, click the checkbox.
G. Click Checkout or you can leave this page F. by pushing the button back.

H. After checking the quantity and the total price, click Buy Now.

Buy License Code

Order Detail Confirmation
Shopping Items
Category Content Price Quantity Summary Shopping Date

New License Code 1 Year USD 69.00 1 USD 69 2017.12.18

Total Price : USOE)

H

Buy Now

I. Log in the Paypal Account and finish the payment.

P payPal
Pay with PayPal
Email

Password

Stay logged in for faster checkout x\i)
Not recommended on shared devices ”

Having trouble logging in?

Pay with a Card

%z | English

How to import the license(s) to X-Sign Manager

Before controlling your device or playing the content remotely, you must pair the device with the

license on X-Sign Manager.

I. You have to buy license(s) from Manager directly or from BenQ reseller. If you buy from Manager,
the license will be sent to your Manager account directly. If you buy from the reseller, you have to

import license(s) yourself.

BenQ X-Sign 2.0



2. Go to License Management > License List and click License Code Mapping.

Available space - 100 GB

e License List
* File
r R License Code Device ID Device name Opened at Expired at Status
Al ACMZGFYA285273LB BYNS8S2M HOMI3 2017-1013 2017-10-20 Expired
i e Marngemer ACMBH383LND3B52C 4BLD2TED HDMi2 20171013 2017-10-20 Expired
I ACMW353R34VEF2SF 23VZH2CE HDMI1 2017-1013 2017-10-20 Expired
By ey icesgeo ACMAJQAUSSTZNSK) 20170010 2017-10-20 Expired
Dy s Sai ACMSGM2KQ32BX4VE 2017-09-19 2017-10-20 Expired
fhio ACM3W3S9HP42BESE 2017-10-30 2017-11-30 Expired
ACMUL493M23X55PD 2017-10-30 2017-11-30 Expired
ACMB3GWZ25IMLTSC 2017-10-30 2017-11-30 Expired
ACM433P32VTHTUBC 2017-10-30 2017-11-30 Expired
ACMG2KYRAP33T7ZH 2017-10-30 2017-11-30 Expired
ACMKGA9SXUVT3IZH 2017-10-30 2017-11-30 Expired
ACMRFIHNW3BDI35F 20171030 2017-11-30 Expired
ACMLGEX333CREK3K 2017-10-30 2017-11-30 Expired

3. Enter the license code here. Click Add to import multiple licenses at one time.

Available space : 100 GB

RED=vc License List

> File Management

» My Favour Please input license(16 characters) m

» REDHT

> Advanced Application

> License Management Back Import license

About

4. After entering the license code, click Import license.

5. You will see the imported licenses on the license list.

License List
License Cade Mapping —
License Code Device I Device name Opened at Expired at Status
ACMAISFCLAZQIIXH New Magpiog
ACMPIEQSZYTALG3A New Wazoing
ACMAIDPZMIE2YUGG New Mappig
ACME2WIK2YP3VZDE New Magping
ACMCZRVTGMSKBAPD New Magping
ACMVZIKIIQWARSXK VRRAXRHE 430R 2017-12-19 2018-12-20 Used
ACMTO32Y22CXAZTA USSGHWLL 430M 2017-12-19 201812-20 Usad
ACMZKAXIE3DASZSH FDEPXNJX 430l 2017-12-19 2018-12-20 Usad
ACMIZ2FO5YSBRSAD X9QU3924 DemaRoomS50K_cantar 2017-12-19 2018-12-20 Used
ACMCMAPG5333QCA New Magping
ACMSH3XSAMF23QE) New prresesy
ACMT233PTZUHIMIG New oo
ACMIAZXFKSULVWEG New Magpng
ACMQNZTGDLEYJAC) New Magping

6. Now you can start to pair your devices.

12 BenQ X-Sign 2.0



How to import Local Delivery license in Windows Player

You can use local delivery function with BenQ Smart Signage Display for free. You need to import
Local Delivery license manually for Windows Player.

I. Press Esc button on Windows Player or MENU on BenQ Smart Signage remote controller to see
the menu bar.

O Settings

O3 Switch Mode

o About

P aut

2. Choose Switch Mode.

== Play from File

£+ settings

o Switch Mode

0 About

E—b Quit

BenQ X-Sign 2.0 13



3. Select Local Delivery And Interactive and press Import License.

Switch Mode

Local Delivery mode: license unbinded
Interactive mode: license unbinded
The source of content is from Designer.

& Standlone(USB)

Device Name: Unassigned
Hardware Token: e4:a4:71:a8:72:43

Import License

Local Delivery
And Interactive

Manager

14 BenQ X-Sign 2.0



4. Enter the license code.

Import License

Please input the license code(16 digits):

* Please make sure the Internet connection is available.

Success

Configuration has been applied.

5. You will see the license binded message from Local Delivery column.

Switch Mode

Local Delivery mode: license binded
{ Ml unbii
The source of content is from Designer.

Standlone(USB)

Device Name: B-54306
Hardware Token: e4:a4:71:a8:72:43

© Local Delivery
And Interactive

Manager

BenQ X-Sign 2.0 15



How to pair the signage with X-Sign Manager

If you want to play the content from Internet or control multiple devices remotely, you have to pair
BenQ Smart Signage with X-Sign Manager.

I. Launch X-Sign Player.

2. Press Esc button on Windows Player or MENU on BenQ Smart Signage remote controller to
see the menu bar.

O Settings
O3 Switch Mode

o About

B aut

3. Choose Switch Mode to switch to Manager mode.

== Play from File

£ settings

o¢  Switch Mode

0 About

E—) Quit

16  BenQ X-Sign 2.0



4. Choose New Device to start pairing.

Switch Mode

@ standlone(USB)

Local Delivery
And Interactive

Manager

Manager mode:
The source of content is from Manager.

Display ID: Unassigned
Device Name: Unassigned

New Device

Existed Device

Close

5. Get the Display ID on this page then go to X-Sign Manager to pair the license.

New Device

Display ID: X9QU39Z4

* Please use the Display ID to pair the license on Manager.

Device Name:

BenQ X-Sign 2.0
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6. Go to X-Sign Manager. Then go to Device Management and choose Add a new display.

w Available space : 100 GB

Device Management

~ Device

.
Add a new display

Channel Management

add category Device Updates

+ B Device Management

File Management

Status ¥ Name Channel name
» My Favour
= 3
v BRI v HDMI3 videowall test
Touch Report (Interactive
template) (Beta) =1
HDMI2 videowall test
QR Code Analysis 7
Remote Monitoring Report
enieoser hepart @ HDMI1 videowall test
wi
» Advanced Application
»  License Management
m lab650K Unsubscribed
About o 3 |
0 B bobbyger

7. Enter required information as below.

* Display ID: the device information from X-Sign Player.

New Device

Display ID: X9Qu39z4

* Please use the Display ID to pair the license on Manager.

Device Name:

*Mapping license code: Choose the license you want to pair with the device. You have to make
sure you already buy the license and import to X-Sign Manager.

18  BenQ X-Sign 2.0



* City of equipment: Choose the city where your device lies in. Time zone of the device
(Android) needs to be the same as you set here.

B Available space : 100 GB

~ Device

| Device Management

Channel Management
*  File Management
» My Favour
rOEEMT
*  Advanced Application
»  License Management

About

8. After you finish the setting, click Finish to continue.

8 Avalable space 100 GB

~ Device

| Device Management

Channel Management

File Management

My Favour

> RERM

Advanced Application
> License Management

About

Device Management

» % Device Management

Add a new display

A\ *Display ID
2

X9QU39Z4

BJ Mapping license code

ACMJ-Z2F9-5Y5B-RSAD

*Device name

DemoRoomS50K_center

C

*City of equipment

Taiwan

Category
Channel

Description

Device Management

» BB Device Management

“Display ID
*Mapping license code
“Device name

*City of equipment
Category

Channel

Description

Uncategorized

Unsubscribed

within 150 characters

Add a new display

X9QU39z4

ACMJ-Z2F9-5Y5B-R5AD

DemoRoomSS0K_center

Taiwan

Uncategorized

Unsubscribed

within 150 characters

=2 |

&2 Account Management 8, bobbyger @ Language

22 Account Management

& bobbyger @ Language

9. A message, “New device has been created”, will show up on the screen when the signage is

successfully paired with X-Sign Manager.

Warning Message

New device has been created

BenQ X-Sign 2.0
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10. You will also see the message shown on the signage.

Switch Mode

Manager mode:
The source of content is from Manager.

Standlone(USB
( ) Display ID: X9QU3924
Device Name: DemoRoom550K_center

Local Delivery
And Interactive

& Manager

Close

I'l. Now you can control your device and play content remotely from X-Sign Manager.

How to upload your content from Designer

With X-Sign 2.0 Designer, you can directly upload your content to Manager. You don't need to save
the project and upload it separately.

* You need to have an account on X-Sign Manager. Refer to How to register an account for X-Sign Manager on

o page 4 for more information.

* Make sure your account has the authority to upload files.

I. Press Login to log in the X-Sign Manager account.

Open the file from Manager

Forget your password ?

20  BenQ X-Sign 2.0



2. Once you have successfully logged in, you can see your account information.

Boutique-Watch-2 1080x1920 w | " " |2 ~

defaultMediaName (Text Slideshow)

®

®

defaultMediaName (Text Slideshow)

e

defaultMediaName (Text Slideshow)

®

defaultMediaName (Text Slideshow)
® @ defaultMediaName (Image)
® T defaultMediaName (Text Slideshow)

@® T defaultMediaName (Text Slideshow)

Name Boutique-Watch-2 1080x1920
BLUESKY Duation 40000
Resolution 1080x1920 Modify

Panel Area i

Background ¥
Color #FFFFFF
Image
Add Delete
Imana Srula (=11 -
(8] Preview Save il
= -
Save and Upload ot
%
@ T defaultMediaName (Text Slideshow)
@® T defaultMediaName (Text Slideshow)
® T defaultMediaName (Text Slideshow)

® @ defaultMediaName (Image)

® T defaultMediaName (Text Slideshow)

@ T defaultMediaName (Text Slideshow)

- T Aiahtar s (Taus Slidnsimd
Property =
Page 7
Name Boutique-Watch-2 1080x1920
Duration 40.000
Resolution 1080x1920 Modify

Panel Area x1

Background -
Color #FFFFFF
Image
Add Delete
P H E E | GT Image Style Fill -
Transitions =
+]
This isa beautiful watch that celebrates the Effect None -
timeless and elegant nautical spirit, capturin
the essence of a summber by the ocean.
Duration -

BenQ X-Sign 2.0 21



4. The file list on Manager will be shown automatically. Choose the path to store the file, then
press Confirm.

-)( Close
———x
File name L] Creator ¢ Size £l Time L]
-
B test] bobbyger 2017-09-28 09:51:47
M testZ bobbyger 2017-09-28 09:51:52
Mi%21.bd x 5
Mista1.bd BTy bobbyger 12 Mb 2017-11-07 10:50:04
SK2.bdp bobbyger 2Mb 2017-12-26 09:09:46

1920x1080 12/26/2017

5. Designer will automatically upload the file to Manager.

If you want to modify a file, you have to choose the same path and upload the file again. Designer will only upload
the changes rather than the whole file.

6. Now you can go to X-Sign Manager to schedule your content.

How to create the channel

Follow the steps A to N to create the channel.

* A. Click Channel Management.

* B. Click Add new Channel to the creation page.
Available space : 99.4 GB

Channel Management
v Device
J‘AE Device Management B))
Add new channel
| Channel Management |
e v Channel name
» File Management R
Normal Uncategorized
> My Favour
Normal 20171218
> REROM
Normal 4321
» Advanced Application
Normal BQE
» License Management
Normal Demo video_testing
About
Normal DemoRoom
Normal JAMBA Juice Store 1
Normal PDM2017_ST550K_L

* C. Enter the channel Name.
* D. Select the default playing content when there is no schedule in this channel.

* E. Choose to enable anti-image retention.

22 BenQ X-Sign 2.0



* F. Fill in the description of the channel.

* G. Click Confirm to finish the creation page.
Channel Management

Add new channel

)
3] Channel name Demo Channel

Play without schedule video

@ lastfile

picture

)
J

) Anti retention & When selecting, we will play an anti-retention animation on your screen hourly.

(We suggest you to enable this setting, when you plan to play a static BDP for a long time schedule.)

Frj Description For Demo Purpose

* H. Select to finish the settings.

* |. Select to add the existing device to the channel.

Group Setting Finished

The channel is successfully created. Are you going to set equipment for this

channel? |
H

|

Setting Finished

Set Equipments

* ]. Re-edit the information of the channel.

* K. Add the existing device to the channel, then you will see a new page.

Channel Management

Channel edit

Channel name Demo Channel
Play without schedule last file
Anti retention Enabled

Description For Demo Purpose

JJ m Delete channel

K

Set Equipments

Add unsubscribed equipments to this channel

Device name =« Display ID

* L. Select multiple displays to add into the channel.

* M. Search the name of the display in the search bar.

Device version Category

BenQ X-Sign 2.0
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* N. Click Confirm to finish the operation.

Channel Management
Add equipments to this channel MJ
Il_ [7]| pevice name « Display ID Device version Category Expired date
)
D ABC123 4SPNANEF 0 Uncategorized
\:! AlbertPC G3XNZLKA 0 Uncategorized 2018-02-27 23:59:59
D Android_Box_W KOQR1YGE 0 Category B
D Barcelona KAY4SQU9 1611 Uncategorized 2017-12-27 23:59:59
D HTML5_DEMO L5E7CMIF 0 Category B
D ST550K_DEMO XT55XISJ 0 Category B/Youtube Demo
\: STS550K_Test LNUs7vzv 0 Category B/Youtube Demo
_
Canc NJ

How to schedule the content in the channel

With X-Sign Manager, you can easily play the same content on multiple displays remotely. You can
also play different content whenever you want.

I. Be sure that the device’s license in the channel hasn’t expired yet.

2. Go to Device > Channel Management, then choose the channel you want to play the
content.

3. Click and you will see the schedule management page of Channel. Click the time slice you
want to set schedule.

Available space : 100 GB & Account Management @ bobbyger ° Language

Channel Management

~ Device
Device Management > . 111
Add new channel 2 1D 22 I 5%
I Channel Management
Type ¥ Channel name Equipment amount
*  File Management
Video wall DemoRoom_430_videowall 3
» My Favour
Normal Unsubscribed 3
* RERSH
& Normal 12345 g
* Advanced Application Normal bobby 2

License Management

About

4. You will see the schedule setup window. Below is some required information.

A. Select the project you want to play on the channel. Be sure to upload your project file to
Manger first.

B. Set the schedule time you want to play the content.
C. Enable to play content all day long.

D. Enable to play content periodically.
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E. You can set time here. You have to set the end date and choose to repeat by day or week.

New Schedule (bobby)

Schedule name within 30 characters

Not selected

M 2017-12-20 ©®  07v:30v:00v

Day Every 1 Day

Wweek  eng M 2017-12-20

5. After all configuration is set, click New Schedule.

6. You will see the schedule on the management page.

Channel schedule management(bobby)

o}

C,! D)

08+ :00v:00~

[Janpay []cyce

New Schedule Cancel

&2 Account Management 8 bobbyger @ Language

020175amrDeconal2335amy — OpmrDeconpl1365pmy

sun Mon Tue Wed

21

Thu

22

dey | wooi [N

Fri Sat

23

24 25 26 27

28

29

30

expired  @@@playing @@®interrupt  @@@not downloaded @Bdownloaded  @M@downloading

Add successfully
The schedule has been created

BenQ X-Sign 2.0
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7. Double click the schedule event, and you can see the status of devices in the channel.

Edit schedule (bobby)

Publish file #i#£21.bdp

Schedule time o) 2017-12-20 ® 07+:30+~00 0 @ 10+:00~:00« [—;Al\ Day Ecycle

® Day Every d Day

Week  eng | #4 2018-02-28

Download progress A

No * Device Name Display ID Download pe  Download resul

rcentage t
1ab650K UDGP7VFP 100 downiloaded

DemoRoomSS0K_center XoQU39Z4 0 not downloaded

Remove schedule Cancel
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How to play the content to single or multiple devices in different channel

Interrupt on X-Sign Manager functions to play content on one or multiple devices in different

U
channels.

I. Go to the Device Management page, then choose the device you want to play the content.

Available space | 100 GB

Device Management £

Add a new display add category Device Updates ] L B O Y sam
+ BB Dovice Management
» File Management M
Status ~ Name Channgl Display ID

~ Device

I Device Management

‘Channel Management

» My Favour
- b ' 581 ]
VORERI HDMI3 Unsubscribed 6YNS8S2M
» Advanced Application
’
Hinsrse Maseckment g: HOMI2 Unsubscribed 4BLD2TBD
About P—
i =5
HOMIL Unsubscribed 28vZH2CE
- o oy oovezcs

= DemoRoom_430K

1 B Taiwan

2. Click to go to the schedule management page.

3. Click Interrupt to set the interrupted schedule.
Device schedule management(DemoRoomS550K_center)

_ 020170amrDeconal2351amy — 6pmrDeconp11357pmy day mn

12/17 Sun 12/18 Mon 12/19 Tue 12/20 Wed 12/21 Thu 12/22 Fri 12/23 Sat

all-day

am 12

am01

am 02

am 03

am 04

expied  @EBplaying  @EBInterrupt  @EBrot -
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4. You will see the schedule setup window. Refer to How to schedule the content in the channel

for more information about A-E.

New Schedule (bobby)

Schedule name within 30 characters

A Publish file Not selected W
r
C

, D

B)‘ Scheduletime 4  2017-12-20 ® 07+:30v:00v to @ o08v00v:00v [ JAlDay []cyce

|
EJJ Day Every 1 Day

week | gna | B8] 2017-12-20

5. After all configuration is set, click New Schedule.

6. You will see the schedule on the management page.

Device schedule management(DemoRoomS50K,_center)

m 020170amrDeconal2351amy — 6pmrDeconpll357pmy day mm

12/17 Sun 12/18 Mon 12119 Tue 12/20 Wed 12/21 Thu 12722 Fri 12/23 Sat

om 1
o
pm
om0
om ¢
o
om 06
om
pm
Add 5 iy
expred  @playny  @Eintenupt  @EBnot downioaded  @EBdownloaded  @dowmloading The schedule has been created
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7. You can also set interrupt for multiple devices in the same category.
[

22 Account Managemont &, boblayger

Device Management e
~ Device
| Device Management =
Clfamel Wsnsgement Add a new display add category Device Updates Z B o Search
» BB Davice Management
*  File Management

Swws - Name Channel name Display 1D
* My Favour
v
T l HOMIZ Unsubscribed GYNSESZM
v Advanced Application
Hgeitie Meegemert ’: HOMIZ Unsubscrined 4BLDZTED
About
=
HOMIL Unsubscribed 23vZHCE
3 B DemaRaom_430K
2 = Tanan

o * Even when the device is in the channel schedule, you can still use Interrupt to play the file.

* A device can only set one Interrupt at one time.
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How to push Real-Time Message to your BenQ Smart Signage remotely

With Real-Time Message on Channel Management, you can easily push instant message to single
or multiple devices. You don't need to edit content again.

I. Make sure that the device has already paired with X-Sign Manager.
2. You must create one channel and move device(s) into it.

3. Go to the Channel Management page. Select the channel you want to push the message to.
Then click &

& Account Management 8

Channel Management

~ Device

Device Management

new chani A * s EER
I i & e . =

*  File Management Type ~ Channel name Equipment amount
* My Favour Video Wall DemoRoom_430_videowall -
vORRR Normal Unsubscribed 5

Advanced Application Normal 12345 o

License Management
Normal bobby 2

About

4. You will see the message settings page.

A. Enter the message you want to push.

B. Choose the style and layout for the message.

C. Set the duration for playing the message. The maximum time to play the message is 24 hours.

24 AccountManagement &, bobbyger (@) Language

Real-time Message History

A Marquee text generator:
\

Ir¥| Type texthere

B )| Textstyle:
2

Font size: Foreground Background
color’ color

® - =H

Marquee setup:

Scrolling text direction Scrolling text position:
Ol > £ Ol - & Of 1
Marquee speed CJ Start time: End time
[
05~ ) @ o - 00 v oo @ o0 - 00 - 00

&= © &>
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5. You can click Preview to see what the effect looks like on your display.

o __Test instant message

MZ% Mhr;rsmton ,ﬁm m '
e —— fEE0 3 it I : 1943
urﬁ WA e | ZRGR: EDETE
by BRI SR

r_-; ‘l'

EXRTE T

T {045 ( Arthur Streston ) wmmﬁmw #E’EJT
R A HER 2 ZF. ™

S-S TR AR TS | W
B, M ﬂ‘ﬁh‘rn 1897

d
£ u?'

6. After you finish the settir;g, click OK.

7. You can click History to see the record of each instant message event.

Duration Content State

2017-12-21 00:00:00-2017-12-21 01:00:00 Testinstantme Sent
ssage

8. You can also see the status or even delete it.
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How to edit the device management structure

On X-Sign Manager, you can manage devices with hierarchical structures which make you control
multiple devices with ease.

I. Click add category to create a folder.

B Available space : 100 GB

Device Management

~ Device

| Device Management

sl Managament Add a new display add category Device Updates
+ B Device Management

*  File Management

Status ~ Name
* My Favour

' ﬁﬁ—’,}*h ! e

*  Advanced Application

»
License Management ,:X-Sign HDMI2

About

): X-Sign HOMIL

)! X-Sign 1abB50K

Device Management e
Add a new display add category Device Updates Soarch
» B Device Management
Status ~ Name Channel name Display ID
=

HDMI3 Unsubscribed BYNS8S2M

A

=]
HDMI1 Unsubscribed 23VZH2C6
- DemoRoom550K _center bobby X9QuU39z4

3 B DemoRoom_430K

0 = Taiwan
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2. You can see the folder structure on the left side. You can easily create a hierarchical folder

structure.

Available space : 100 GB

Device

Device Management

Channel Management

File Management

My Favour

BT

Advanced Application
License Management

About

Device Management

~ [ Device Management
B8 DemoRoom_430K
- &5 Taiwan
B Kaohsiung

B Tapei

Taiwan

Add a new display

Status ¥

add category Device Updates

Name

I Tapei

B Kaohsiung

3. Click Add a new display then set it to the related category.

R

Device

Device Management

Channel Management
File Management
My Favour
RN
Advanced Application
License Management

About

Device Management

Add a new display
~ % Device Management
BB DemoRoom_430K
- I8 Tawan *Display ID
8 Kaohsiung -
*Mapping license code Chbose
BB Tepei

*Device name

*City of equipment

Choose

i

Category Taiwan v Kaohsiung
Channel Unsubscribed
Description within 150 characters

4. You will see the device in the related folder.

Device Management

~ B Device Management
8 DemoRoom_430K

~ I8 Taiwan

Tapei

22 Account Management &, bobbyger @ Language
Taiwan » Kaohsiung e
add category Device Updates Search. Q
Status ~ Name Channel name Display ID
E 1ab650K bobby UDGP7VFP

BenQ X-Sign 2.0
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5. For existing device(s), click to move it to the correct folder.

Device Management

Add a new display add category Device Updates ﬁ f_‘ {Q o w5 Search

~ B Device Management

Move
B8 DemoRoom 430K Status ¥ Channel name - Display ID
~ B8 Taiwan
B8 Kaohsiung HDMI3 Unsubscribed 6YN58S2M
B Tapei

HDMI2 Unsubscribed 4BLD2TBD

HDMI1 Unsubscribed 23VZH2C6

DemoRoom550K_center bobby X9QU39Z4

iR 0E

3 = DemoRoom_430K

1 = Taiwan

~ [ Device Management
B8 DemoRoom_430K
~ I8 Taiwan
IS Kaohsiung

B8 Tapei

6. Now you can start to customize your display structure.
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How to control BenQ Smart Signage remotely

With X-Sign Manager, you can control your devices remotely. The function is only compatible with

BenQ Smart Signage Series’ hardware.

I. Make sure that your device is already paired with X-Sign Manager and is online.

Device Management > Taiwan > Tapei

Add a new display add category Device Updates
» [ Device Management

Status ~ Name

Channel name

bobby

2. Go to the Device Management page, choose the device you want to control, and click ¢ .

22 Account Management &, bobbyger @ Language

8 Avatae space 100 GB
iliDevice Device Management > Taiwan - Tapei
Channel Management .
> File Management Atld a new display, add category Device Updates I - VS Q@ % sam
+ B Device Management

> My Favour Advanced setting
Status ~ Name Channel name b

v WA

* Advanced Application ° - DemoRoomS50K _center bobby X9QU39Z4

» License Management

About

3. You will see the Device control page.
A. Control the screen.

B. Reboot the device. The device will automatically launch X-Sign Player after rebooting.

C. Remove all playing content from the device.

Device Management - Taiwan - Tapei

Advanced setting ( bevice name : DemoRoom550K_center )

+ [ Device Management

Device control

Screen Control

\ Update status immediately
A -

Screen On/Off: . On
Sound On/Off: D Off qate

time2017-12-21 18:16:54]

ync time2017-12-21 18:16:54)

Power Control

B =
2
Clear data
(Gy
) Clear device seftings Clear

4. You have to reload this page after setting the device to get the latest status.

BenQ X-Sign 2.0
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How to update device Player remotely

With X-Sign Manager, you can easily update X-Sign Player on your devices remotely.

I. Go to Device > Device Management.
2. Click Device Updates.

wailable space - 100 GB

~ Device Device Management

Device Management

Channel Management

File Management Add a new display add category Device Updates
» B Device Management

My Favour
Status v Name Channel name

L

Advanced Application HOMI3 Unsubscribed

J

License Management

About
s * HOMI2 Unsubscribed
1
HDMIL Unsubscribed
3 = DemoRoom_430K

2 W Tawan

3. You will see a list of devices available to be updated. Select the device(s) you want to update.

Device Management > Taiwan > Kaohsiung

Device Updates

» [ Device Management

Device name Channel name Category Description

D 430L DemoRoom_430_videowall DemoRoom_430K
D 430M DemoRoom_430_videowall DemoRoom_430K
[C] g430r DemoRoom_430_videowall DemoRoom_430K
[] §DemoRoom550K _center bobby Tapei
¥ Jiavssox bobby Kaohsiung

et

During updating, the playing process will temporarily be stopped.

5. After the device is updated successfully, it will be removed from the list. The device will be
updated to the latest version of Player.

6. If the device is offline, the system will wait until the device is online and send the update request.

Device Updates K3

[___] Device name Channel name Category Description Current version Previous update time Update status

O 4s0L DemoRoom_430_videowall DemoRoom_430K v20383 Have not update yet
D 430M DemoRoom_430_videowall DemoRoom_430K v2.083 Have not update yet
D 430R DemoRoom_430_videowall DemoRoom_430K v208.3 Have not update yet
[[] DemoRoomS50K_center bobby Tapei v2083 Have not update yet

1ab650K bobby Kaohsiung v206.3 Waiting for update after
online
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7. If you want to update Player from 1.6.X to 2.0.X, you have to reboot the device or the device
can't play content normally. It's highly recommended you use device control function on X-Sign

Manager, which can make you reboot device remotely.

Device Management » Taiwan - Tapei

+ [ Device Management

Device control

Screen Control

Update status immediataly Refresh

Advanced Settl'ng ( Device name : DemoRoom550K_center )

Sereen On/Off ® o
Sound On/Off B of
Power Control

Clear data

Clear device settings m

How to switch the mode of Player

There are three modes for Player to play the content:

» Standalone (USB): Directly play the content from USB.

X-Sign Designer

X-Sign Player

X) =

* Design the Content
Save the content to the USB

Display the content
Interact with the end
customers

BenQ X-Sign 2.0
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Local Delivery (need the license): Play the content from Designer connected in the same subunit

with Player.
X-Sign Designer X-Sign Player
>
¢ Design the Content * Display the content
¢ Deliver the Content * Interact with the end

38

customers

Manager (need the license): Play the content from Internet. Player has to pair with Manager.

X-Sign Designer X-Sign Manager X-Sign Player

l
%)

* Design the Content *  Schedule the content * Display the content
* Upload the Content *  Control the device * Interact with the end
¢ Monitor the status customers

Press Esc button on Windows Player or MENU on BenQ Smart Signage remote controller to see
the menu bar.

o Settings

o3 Switch Mode

o About

B it
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2. Choose Switch Mode.

Play from File

Settings

Switch Mode

[

About

Quit

3. Select the mode you want to play the content.

How to play files with USB

In X-Sign Player 2.0, for standalone function you can play files with your local storage or everywhere

with your USB. The following is an introduction of how to play file from USB.

Switch to Standalone(USB), then press Close. Refer to How to upload your content from

Designer on page 20 for more information.

Switch Mode

@ standlone(USB)

Local Delivery
And Interactive

Manager

Standlone(USB) mode:
The source of content is from local or USB.

Close

BenQ X-Sign 2.0
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2. Tab the menu bar again, and press Play from File.

Play from File

a Settings

o Switch Mode

© About

P it

3. Keep pressing Back to go back to the root folder. Then go to the "mnt" folder.

Selext X-Sign playable file:
Play
= = = =
lib mnt mslib proc

O 0O (] (]

root shin sdcard selinux
storage sys system tmp
Close
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4. Select the "usb_storage" folder.

Selext X-Sign playable file:

Play

- - 0O ] L ek

asec iso obb samba

O B 0O |

sdcard secure shell usb_storage

Close

5. Choose the file you want to play, then press Play.

Selext X-Sign playable file:

O [+ | O O [ sk

Android DemoRoom_IL.xplan LOST.DIR Snow Mountain

- [+ ] a |

System Volume interactive template.xplan interactive_potrait.xplan otohtey
Information

Close

6. Now you can enjoy your content.

Once you play files successfully, the path will be remembered. You don't have to choose the path again next time
you play files.
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How to create a new project file in X-Sign Designer

In X-Sign Designer 2.0 you can create your own project with customizable features. The following is
an introduction of how to get started with a new project.

To create a new project file in X-Sign Designer:

I. Launch the software and click New project.

File Edit Insert  Amange  View  Prewiew  Help  LocalDelivery

v m =* |

3|

Open Project New project New Interactive Project Local delivery

Demo Video

2. To customize the project settings, configure the following items:

A - I C:\Users\Michael.vokins tp\Documents |

B Project name | ‘ ‘l

‘ |@ Landscape (O Portrait Single display resolution: | 1920x1080 |

D Panel Area 1 >l X (N >

Video wall resolution: 1920x1080

Confirm

A. Project Location - Select the folder where your project will be saved.
B. Project Name - Create a name for your project.

C. Project Orientation and Resolution - Choose the layout and size of your project.
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D. Panel Area - Adjust this setting for creating a video wall project.

3. Select Confirm to create the new project file.
4. To adjust the project settings after a project has been created, click Modify in the Page panel.

[®] Preview E save ~ ® Logn ~

- + K e | I E -
Layer »
Property -
Page -
Name New Page (4)
Diwibion 10:00.000
Resolution 1920x1080 Modify

Panel Area 1x1

Background -
Color #FFFFFF
Image
Add Delete
Image Style Fill -
Transitions v

5. To import media into your project, click the Image or Video button in the Basic Tool panel.
[}

/ Storefront New Page (4) -
Basic Tools
T Cad
Text Image
i =i
Video Rectangle

Oval

6. Select the media file to import and click Open.
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How to open an X-Sign |.6 project file

X-Sign Designer 2.0 can open projects created in X-Sign Designer |.6. The following is an
introduction of opening and saving an X-Sign Designer 1.6 file.

To open an X-Sign Designer 1.6 project:

I. Launch the X-Sign Designer 2.0 software and click Open Project (You can also select File >
Open Project or Ctrl + O).

File Edit Insert Arrange View Prewiew Help Local Delivery

i

N

[ ] |
=1
%

_ % i‘,l |

Open Project New project New Interactive Project Local delivery

-

Demo Video

2. Click Browse your folder. Locate the |.6 project file on your hard drive and click Open.

(% Close )

%/ Select X-Sign Project o
@@-\ ). « BENQ » xSign20 » Source » [ 43 ][ Search Souree ol
o Recent Mission Ot Mo i =~ 0 @
[4 Documents  * Name " Date modified Type
& Music X §
_ 1| X-Sign L6 files 02/03/2015 430 PM  File folder
| Pictures
n B i || ¥-Sign 20 introcluction 15/03/2018 1125 .. File folder
e 1| X-Sign 2.0 UM 20180130 EN.pdf 02/03/2018 441 PM  File folder
1| %-Sign Software 2.0 and password 05/02/2018 514 PM  File folder
18 Computer
= & XSignCloud & local Disk (C)  |E

s Data (D)

¥ BackupData (\\E|

¥ Common (\ETA

58 michaelvokinsy

S8 Case (WETA-File-

S8 Client (\ETA-Filc

5 Remote Job ME ™ ¢ | m | -

File name: ~ | X-Sign Projects (scenexml;®as ~

i Browse your folder
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3. Once opened in X-Designer 2.0, X-Designer 1.6 project files will be automatically saved to a 2.0
project file. To save the project as an X-Sign Designer 2.0 file, click either the Save or Save As
button in the top right corner (You can also select File > Save or File > Save As).

®  “| SavehAs | =T

Layer = Save and Upload -
(o] D T AR T A TR TR
4. Rename the project and choose the location on your hard drive, then select Save.
Organize Mew folder = - ®
I Favorites — Documents library B o Fotdes =
Bl Desktop luxury
4 Downloads 3 MName Date mndvified Type
‘£l Recent Places
| assets 07/02/2018 3:00 PM  File folder
== |ibrari | data 07/02/2018 3:00 PM  File folder
- Libraries
@ — @ assets.xml 08/02/2018 3:32 PM XML Documen
J’ Music @ scenexml 08/02/2018 3:32 PM XML Documen
= Pictures uﬁ preview.png 08/02/2018 3:32 PM  PMGImage
B Videos %] storage.db 07/02/2018 2:29 PM  Data Base File
o ~ (] | 3
File name: Storefront_July -
Save as type: [(All Files (%) v]
= Hide Folders [ sve [ conce |

How to create content in X-Sign Designer

Once you have opened a new project, you can begin to customize the content for your project. The
following is an introduction to the basic settings used to create content in X-Sign Designer 2.0.

To create content in X-Sign Designer:

I. Click the f button to open the Basic Tools panel. The Basic Tools panel allows you to add

text, media and shapes to a page. Click on one of the following icons to add a new element to the

canvas:
Edit Insert Arrange View Prewiew Help Local Delivery

V4 Starefront Mew Page (4)

Basic Tools

TIA|=B

Text Image

Z\c YD

Video Rectangl}
|_Cual |
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A. Text — Add a new text box to a page. Double-click on the text box to change the text.

B. Image — Add a new image bounding box to a page. A window will automatically appear to
select an image from your hard drive, then click Open.

C. Video — Add a new video bounding box to a page. A window will automatically appear to
select a video from your hard drive, then click Open.

D. Rectangle — Add a new rectangular bounding box to a page. Adjust the color, border and
shadow in the Content panel.

E. Oval — Add a new circular bounding box to a page. Adjust the color, border and shadow in the
Content panel.

Click the M button to open the Widgets panel. The Widgets panel allows you to add

specific widgets to a page. Click on one of the following icons to add the respective widget to
the canvas:

File  Edit Insert Amange View Prewiew Help  Local Delivery

*
L Edit mode

— Storefront New Page (4)
Widgets
A B
C) )
Clock Weath:
C D
o 1
Video Slideshov] | Image Slideshow
E E
G &l
e

>
&l
]
2 Ea
(&
=
>

2zl
. B~ %|I

P OIX |

E

=
2
=
[
&
=
=]
&

—

-
=
=
®
L
gl

A. Clock — Add a clock to a page. The time is based on your device’s region setting. Adjust the
settings in the Clock panel and the Content panel.

B. Weather — Add a weather forecast to a page. Weather forecast is based on your device’s
region setting. Adjust the settings in the Weather panel and the Content panel.

C. Video Slideshow — Add a new video slideshow to a page. Refer to How to create an Image
or Video slideshow on page 54 for more information.

D. Image Slideshow — Add an image slideshow to a page. Refer to How to create an Image or
Video slideshow on page 54 for more information.

E. QR Code — Add a QR Code to a page to link to an external website. Adjust the settings in the
QR Code panel and the Content panel.
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4. Click the Overview button to configure the project layout and order.

F. Web — Add a website to a page. Adjust the settings in the Web panel and the Content panel.

G. RSS — Add an RSS Feed to a page. Adjust the settings in the RSS panel, the Content panel
and the RSS Config panel.

H. Data Connection — Add a data document to a page. Data is based on a csv document saved
online. Adjust the settings in the Database Connection panel, the Setting panel and the
Content panel.

J. Text Slideshow — Add marquee text to a page. Adjust the settings in the Marquee panel, the
Content panel, the Carousel panel, and the Transition panel.

K. Calling System — Add a waiting number window to a page. A waiting number system can be
created by logging in to your X-Sign Manager account and going to Advanced Application >
Queuing System. Once created, return to X-Sign Designer and adjust the settings in the
Waiting Number panel and the Content panel.

L. YouTube — Add a YouTube video to a page. Adjust the settings in the YouTube panel and the
Content panel.

M. Timer — Add a timer to a page. Adjust the settings in the Timer panel, the Settings panel
and the Appearance panel.

In Edit mode, you can add and customize different pages:
Edit Insert Arrange View Prewiew Help Local Delivery

Edit mode vervizw

Vd Storefront Main Page
Basic Tools Specials
Price List
T Cad
Text Image
Video Rectangle

Oval

A. Pages Drop-down menu — Navigate to different pages by selecting ™ at the top of the
canvas.

B. + — Add a new page by clicking on the + Button at the top of the canvas.

File Edit Insert Arrange View Prewiew Help Local Delivery

[ overview [¥] Preview Save ~ @ Login ~

Music + =" Repeat [-] RepeatOne

01 02 03

STRAWBERRY :
FESTIVAL = § 2
e £ % ¢ - - W CAKE
e - O =
- & = =
k‘a—t g. - =" LR =S LE DRINK
Main Page Specials Price List

Repeat 1 time(s) fTu‘taIpIayingtimeDﬂS Repeat 1 time(s) ETma!paning time 0:45 Repeat 1 time(s) Total playing time ! 25
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5. You can move pages by dragging the page icon to the left or the right.

Prewiew Help Local Delivery

[®] Preview E save - @ Logn =

Starefront
. P Music -+ = Repest [-] RepestOne

0 « 0z
.7 g
FESTIVAL

ES o e i B { S B
= X .3 £, 4 . L B A Ll s e B3
e L = O A L,
B 'P_‘,‘.E* Y e w E EOiE

Main Page Specials

Repeat 1 time(s) I‘rmal playing time 0:45 | Repeat 1 time(s) rrotalplaymgth“neu: Repeat 1 time (s) |Total playing time ! 25

6. To delete pages, hover your cursor over the page icon and click Delete page. A warning
message will appear, select Confirm to delete the page.

File Edit nsert Arrange Prewiew Help Local Delivery

C

( ew ] Preview E save ~ @ Logn ~

Stnre[}manst Musie + =" Repeat [] RepestOne

01 02 03

CARDH L

Edit mode

STRAWBERRY Set Link Area
FESTIVAL &%“

gree
TN

Delete page
Spectats
Repeat 1 time (s) Total playing time 0:4;

Main Page
Repeat 1 time(s) ITMaI playing time 0:45

Price List
Repeat 1 time(s) Totalplaying time ! 25

Are you sure to delete this page?

Confim Cancel

7. Select ™ on the page icon and click Set Repeat Time(s) or Set Total Playing Time to
have the page repeat or change the time duration for a page.

Arrange Prewiew Help Local Delivery

Qverview [»] Preview B save ~ @ Logn ~

Storefront
aret ]mans Music + =" Repeat [ Repeat One

01 02 03

STRAWBERRY -
FESTIVAL iy
k. o
e
Main Page Specials
Repeat 1 time(s) =  Totalplaying time 0:45 | Repeat 1 time(s) - |  Totalplaying time 045 Repeat 1 time(s) + | Totalplayingtime 0:05 |

Set repeat time(s) A
Set total playing time B

A. Repeat __ Time(s) — Double-click the number to change the amount of times a page plays.

B. Play 0:00 — Double-click the run time to change the time duration for a page.
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8. Click Repe

File Edit Inser
+ '

»

at

or Repeat One to choose the play sequence for a project:

Prewiew Help Local Delivery

IB Preview @ Save ~ @ Login +

135 Music -+ | =" Repeal | ] RepeatOne
01 02

Storefront

03

STRAWBERRY
FESTIVAL

.

e
G

Main Page
Repeat 1 time(s) |Total playing time 0:45

Specials

Repeat 1 time(s) Total playing time 0:4 Repeat 1 time (s) [Total playing time 125

A. Repeat — To play all pages in order in a continuous loop, click Repeat then click Confirm.

B. Repeat One — To play a selected page on a continuous loop, click Repeat One then click
Confirm.

You can preview your project by clicking the Preview button. This will play the current project
in X-Sign Player. Click ESC to return to X-Sign Designer.

Prewiew Help Local Delivery

File Edit
/5 '

» [»] Preview E save - @ Logn ~
S'me'_:“;; Music + = Repest [-] RepeatOne
01 02 03
STRAWBERRY :
FESTIVAL U_;};‘

Main Page
Repeat 1 time(s) rrmal playing time 0:45 Repeat 1 time(s) I'I'otalplayhgtmuza

Repeat 1 time (s) Total playing time | 95
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How to create content from Designed Templates

Once you have opened a new project, you can use Designed Templates to quickly generate
content. X-Sign Designer 2.0 has numerous Designed Templates of varying orientations and
resolutions for the user to easily access.

To create content in X-Sign Designer using a Designed Template:

I. Click the BB button to open a list of templates.

File Edit Insert Arrange View Prewiew Help Local Delivery

E Storefront New Page (4) > o+ X[ IEI >
Template Layer »
Bank » Property *
Bar » Page -
Boutique » Name New Page (4)
Campus -
’ Duration 10:00.000
Resolution 1920x1080 Modify
mpu&ﬁlm ..  Campus-sche..
1520x1080 1920x1080 Panel Area 1x1
Background -
[
|SWOT.. Campus_sch... Color #FFFFFF
1920x1080 1920x1080
Corporation » Image
Cosmetic » Add Delete
Dessert »
Image Style Fill =
Exhibition »
Fast Food » Transitions -

2. Click the drop-down menu for the type of template you want to use and then click icon for the
template you want to use for your project. A new page with the template will automatically be
added to the project and displayed in the canvas window.

Edit Insert Arrange View Prewiew Help Local Delivery

iz | Storefront New Page (4) N
Template
Bank »
Bar »
Boutique >
Campus v

Campusfilm .. | Campus-sche..
1920x1080 19201080

=z
Campus-wor.. Campus_sch...
1920x1080 1920x1080
Corporation »
Cosmetic »
The template must match the orientation and resolution of your project settings. To modify your project
settings, refer to How to create a new project file in X-Sign Designer on page 42 for more information.
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3. You can test out different templates in the canvas. X-Sign Designer 2.0 keeps a saved page of all
templates selected. Once you'’ve finalized your pages, you can delete unused pages by clicking the
Overview button. Hover your cursor over the icon of the page you want to delete and click
Delete Page. A warning message will appear, select Confirm to delete the page.

File Edit Insert Arrange View Prewiew Help Local Delivery
P .
. o [ roven =T Dlm
Hana; i; Musie + = Repeat L1 Repestone

01

03

Edit mode

Set Link Area

Delete page

Campus-schedule_day 1920x1080 Campus_schedule_days T920xT7080 Exhibition info 1920x1080
Repeat 1 time(s) Totalplaying time 1:15 Repeat 1 time(s) Totalplayingtime1:15 Repeat 1 time(s) Total playing time 0:16

Are you sure to delete this page?

Confirm Cancel

4. Alter text in the template by double-clicking the text box in the canvas and typing in your own
text.

Edit Insert Arrange View Prewiew Help Local Delivery
/ Hallway 01 Campus-schedule_day 1920x1080 - 4 x| |.5 v
Basic Tools Layer -
@® T. defaultMediaName (Text Slideshow)
T G ® T defautMediaName (Text Slideshow)
Text Image

@® T. defaultMediaName (Text Slideshow)
® T defauttMediaN (Text Slideshow)
] O WORKSHOP SERIES o ittt

Vo Rectangle Professional And Development Workshops For Studentsgy Sep 5“ © | T defauftMediaName (Text Slideshow)

@ T. defaultMediaName (Text Slideshow)

= ._ Programming Courses / Dr. Christina Abrec.

Gel a brinf four of aur programeming courss + @® T. defaultMediaName (Text Slideshow)
Oval Design Gourses | Ms. Karen PGpR. . & W Anfaubbdadiakiaeen (Tavk Clidachaw)
[Get = brief tour of our design coursi+ Bam 11z + Property e
+
Media Courses | Dr. Samuel Wheele-+ saan [| TextSideshow 7]
Gel & brief tour of our media course. + Bpm3pi s
Y Name  defaultMediaName
X 870 - v 789 = I
Width 500 - Height 32
Rotate 0 Z

Transpa.. =il
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5. You can replace images or video files by selecting the item in the canvas, then click on the ...
Button in the Content panel. Select your own image or video to insert into the bounding box.

Edit Insert

Edit mode

T P

Text Image

= O

Video Rectangle

&

Oval

WORKSHOP SERIES

Professioral And Development Workshops For Studentsgg

Local Delivery

Campus-schedule_day 1920x1080 - -+

Programming Courses / Dr. Christina Abrec,
Gol a brief tour of our programeming courss +

[El Preview Save ~ @ Logn =

Sep.15,

Get & brisf tour of our deeign cours: +

R207%

Bam-11z +
+

Media Courses / Dr. Samuel Wheele+
Gat & brief tour of our madia courss. -

S30%

Business Courses | Mr. April Huddlestor +'
Gel a brief tour of our business course.  +

LY = -
Layer 8
Property -
Image =

Name defaultMediaName

X oS! v 224 °
Width 640 T  Height 658
Rotate 0 =

Transpa.. ——————--—ou@

Content -
e 3091097189.png D
T one -
e R -
Shadow B

Fixed Ratio »

6. You can customize widget information by selecting the respective widget in the canvas, then
adjust the settings in the Content panel.
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Edit Insert

Basic Tools

i k Cad

Text Image

> ()

Video Rectangle

O

Oval

BenQ X-Sign 2.0

Local Delivery

Campus-schedule_day 1920x1080 > B

WORKSHOP SERIES

Professional And Development Workshops For Studentsgg

Programming Courses / Dr. Christina Abrec,
Gt a briof tour of our programming courst +

[ﬂ Preview Save ~ @ Login -

Design Courses / Ms. Karen Popf+

Media Courses / Dr. Samuel Wheele+'
(Geta brief four of ourmedia course.  +

= 2 1
Business Courses / Mr. April Huddlestor+
[Gel a brief tour of oUr business course, -+

x|~ (=
Layer »
Property i
Weather -

Name defaultMediaName

- -

X 0 oy Y 882 _
Transpa.. =————————————

Content -

Display Format  Five days (horizontal) =

Color ‘ #FFFFFF

O Sync with X-Sign Manager
(® Manually Select

Source REPLACE

AQl
Information D



7. You can move objects on a page by selecting on the bounding box in the canvas and dragging it
to the desired location.

Edit Insert Arrange View Prewiew Help Local Delivery

Edit mode [E! Preview Save @ Login -

Va Hallway 01 Campus-schedule_day 1920x1080 - o+ || = -

Basic Tools Layer 3

Property b

T Cad Text Slideshow -
Text Image

Name defaultMediaName

IAlARIZAALIAR AFERIES X 16103 v 139 2
> - VWURNOMUF "OCRICY
Video Rectangle E’mfessinna\ And Developmezﬂt Workshops For Studenls;! Width 1,190 2 Height SO
Programming Courses / Dr. Christina Abrec. Rotate 0 :
Q # i Gel a brief four of our programming courst +
Oval
Design Courses | Ms. Karen Popg+ L
Get & brief four of our design coursi+
Media Courses / Dr. Samuel Wheele+ il -
Get & brief tour of our media course. +
Font Abel =
Business Courses / Mr. April Huddlestor+'
Gl briel tour of oUr busingss Course, +
Font Size 46
T ||| L
Line Spacing 0 =
Character 0 -
Spacing -
Color #FFFDC7
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How to create an Image or Video slideshow

You can use the Image slideshow or Video slideshow widget to play multiple media files in
succession within one window of the project. The following is an introduction to creating an image or
video slideshow.

To create an image or video slideshow in X-Sign Designer:

I. Click the - button to open the Widget panel and click either the Image slideshow or the
Video slideshow widget.

Edit Insert Arrange View Prewiew Help Local Delivery
] Hallway 01 New Page (4) - o+
Widgets
Clock Weather
Video Image
==
B E]
QR Code Web
&
RSS Data Connection

2. A new bounding box will appear in the canvas area. Select the + button on the lower right

corner of the bounding box to add images or videos.
Edit Insert Arrange View Prewiew Help Local Delivery

] Hallway 01 New Page (4) S
Widgets
Q| B
Clock Weather

Video Slideshow Image Slideshow

: E] -
e B £
QR Code Web
|
RSS Data Connection ]
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s
X Select image file: E
e,
@U-| || & Dessert b Dessert-11920x1080 b sssets [ 44| [ Seorch assets )
Organize v MNew folder =« O @
“El Recent Places = - - FESTIVAU e el -
1775444677.png  198876869.png  2102188116.png  2161050546.png
4 Libraries e -
@ Documents
Jl Music
Picty
[T STRAWBERRY] L
B videos 2323359561.png  2438896119.png | 2678948725.png  3185256865.png I
1% Computer o f s |
&, Local Disk (C) 1.3
—a Data (D2) = 4 W
5® BackupData (\\E”
S8 Common (META 3323586278.png  35338031png  35723133%9png  308891196L.png
4 michaelvokins.tr ™ I 3
File name: 2678948725.png - I]mageiiis (*.jpg *.png *.gif *.b ']
[ Open ] [ Cancel ]

'I

3. Select one or more images or videos to import and click Open.

4. You can resize the slideshow by clicking and dragging on the square nodes of the bounding box.
Local Delivery

Edit Insert

Arrange

Edit mode

View

Prewiew

Help

Clock Weather

Video Slideshow Image Slideshow

G E]

QR Code Web

N &

RSS Data Connection
.18
Ta

Text Slideshow Calling System

Hallway 01

New Page (4]

BenQ X-Sign 2.0
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5. To customize the Image slideshow settings, adjust the following items in the Order panel and
the Transition panel:

Hallway 01 New Page (4) - o % [ = -

Layer »
Property A
Image »
Background »

Order v

i 2230272421 png 5

£l
=L 512802696 png A 58
@ 3800509085.png 5s

el
.

i - .

Pt I

B C

Delete

—— |
et

Replace |

Transition v
O Common Settings

D
@ Custom Settings E
F

Duration 5.000

G v |G -
0 X:204  Y:407 W:440  H:437 -+ 3% o I
A. Image Slideshow Order — Select the image and drag it upwards or downwards to re-order the
slideshow.

B. Delete — Select an image to delete and click the Delete button.
C. Replace — Select an image to replace and click the Replace button.

D. Common Setting — Select to make the image last 5 seconds and have no transition effects
and a normal transition duration.

E. Custom Setting — Select to customize the transition settings using the values below:
F. Duration — Select an image and type in the duration time and press Enter.
G. Transition effect — Select a transition effect for the entire slideshow from the menu.

H. Transition duration — Select a transition duration for the entire slideshow from the menu.
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6. To customize the Video slideshow settings, adjust the following items in the Order panel and
the Transition panel:

Hallway 01 Mew Page (4) - s x [ |- -
Layer »
Property v
Video »

Order v

N 142545247 mp4

165
3 01050011.MP4 A 13s

i
. B C
- el

| Delete | Replace |

Transition =

Display Time 16.962 D

-

A. Video Slideshow Order — Select the video and drag it upwards or downwards to re-order the
slideshow.

B. Delete — Select a video to delete and click the Delete button.
C. Replace — Replace - Select a video to replace and click the Replace button.

D. Display Duration — Select a video and type in the duration time and press Enter.
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How to rotate an image or video

The following is an introduction of how to rotate images or video in X-Sign Designer 2.0 and X-Sign
Player 2.0.

To rotate an image in X-Sign Designer:

I. Click and hold the rotation tab located at the top of an image or video file in a project. Drag to
the left or right and release at the desired degree of rotation.

File Edit Insert Arrange View Prewiew Help Local Delivery

" .
Edit mode Overview [El Preview, dine @ Logn
/ Storefront Specials - 4 x [ B IE -
Basic Tools Layer -
@® Tu defaultMediaName (Text Slideshow)
T [2 ® T: defaultMediaName (Text Slideshow)
Text image

® T: defaultMediaName (Text Slideshow)
® T: defaultMediaName (Text Slideshow)

s ()

@® T: defaultMediaName (Text Slideshow)
Video Rectangle

® T: defaultMediaName (Text Slideshow)

@® Tu defaultMediaName (Text Slideshow)

-

Oval & T dofaukbdadiahiamo (Tavt Slidachod

Image -I

Name defaultMediaName

X 1,28005| Y 380

Width 320 - Height 320

Rotate 14

Transpa.. s——_

2. You can also rotate an image or video by manually changing the value in the Image or Video
panel.

@ | T: defaultMediaName (Text Slideshow)

® T: defaultMediaName (Text Slideshow)

& T dafanBbdadinbaman (ot Clidnch oo

Property -

Image -I

Name defaultMediaName

X 12805 v 380 _
Width 320  Height 320
Rotate 14 =

Transpa.. =9
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How to set background music in X-Sign Designer

Once you have completed a project, you can add a music file to play in the background when the

project is displayed. The following is an introduction to adding music to the background of a project.

To add music to a single page in X-Sign Designer:

I.

While the project is in Edit Mode, go to the Audio panel and toggle the With Background
Audio switch to the on position.

Edit Insert

Edit mode

Basic Tools

Rectangle

Arrange  View

Prewiew Help

Storefront

copp @

+

Local Delivery

Price List

[+]
]
[ +]

+ 0+
[+ N+ ]
[+ Q-+

flavor + [dpce+Binc+
Cheese cake + 80 +580+
Cupcake + 90 +690+
Chocolate cake + B0 +680+
Lemon roulade + 100+700+

flavor + M+l +

flavor + dpce+linc+

Napoleons + 80 +580+
Mango mousse + 90 +690+
Chiffon cake + 80 +680+
Cheese cake + 100700+

Page
Background

Transitions

Effect None
Duration Norm

Background Audio

al

| 10 With Background Audio

Source

o Make sure no bounding boxes are selected in the canvas in order to access the Audio panel.
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2. Select the ... Button to import a music file. Choose the mp3 file from your hard drive and click
Open.

-+ x ' = -
Layer »
Property =
Page 4
Background »
Transitions A

Effect None b

> oo o
“ADOYN " T
ARON
Background Audio b
+| lpci+Binc+ flavor *| 1pce+Bing +
e + B0 +580+ MNapoleons + 80 +580+
+ 90 +690+ Mango mousse + 90 +690+ . With Background Audio
cake + BO +680+ Chiffon cake  + B0 +680+
ilade + 100+700+ Cheese cake + 100+700+
Source
t. .
oot -
+ 80 +130+ " ’
+ 90 +150+ !
+ 80 +140+ -‘ = ="
+ 100 +160
Ea DRINK Volume L

Mute

Loop &

X Select file: =5

@Q-| | <« MIKESFX » SI6000 Series » CD 6001 ~[4][s o
Organize = New folder - 0 @

@ Music A Neme £ Tite Contributing artist *
=] Pictures |#] Track19.mp3 19 Track19 Sound Ideas
B videos | 2] Track 20.mp3 20 Track20 Sound Tdeas
| Track 21.mp3 2 Track 21 Sound Ideas
Computer B |4 Track 22.mp3 2 Track 22 Sound Ideas
£ Local Disk (C:) #] Track 23.mp3 23 Track 23 Sound Ideas
a Data (D) L & Track 24.mp3 24 Track 24 Sound Ideas
¥ BackupData (\\E'| 1 | Track 25.mp3 25 Track 25 Sound Ideas
5# Common (\ETA| |4 Track 26.mp3 2% Track 26 Sound Ideas
5# michaelvokinstj & Track 27.mp3 27 Track 27 Sound Ideas
5 Case (\\ETA-File- & Track 28.mp3 2 Track 28 Sound Ideas
@ Client (\ETA-File | Track 29.mp3 29 Track 29 Sound Ideas

53 Remate_Job [\ |4 Track 30.mp3 0 Track30 Sound Ideas -

58 Temo META-Fil ™ ¢ | '" I '

File name: Track 20.mp3 ~ | Music file (*.mp3)
[Coem ]
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3. You can adjust the following items in the Audio panel:
-+

[+ 1+]

[+] a

[+ [l

[+ ]

4]

+ [lpce+Bing+ flavor + lpcos+hinc+
ke  + 80 +580+ Napoleons + 80 +580+

+ _90 +_690+_ Mango mousse + 90 +'69|‘.I+_
1cake + BO +680+ Chiffon cake  + 80 +680+
wlade + 100+700+ Cheese cake + 100+700+

x ||~
Layer
Property
Page
Background

Transitions
Effect None
Duration Normal

Background Audio

@ Wwith Background Audio

Source

Volume @ )‘s\
| Mute | il | IE;
[ «®]|C

A. Volume — Adjust the slider to increase the volume.

B. Mute — Toggle the switch to mute or unmute the background music.

C. Loop — Toggle the switch to loop the music file or to play it one time.

To add music to an entire project in X-Sign Designer:

I. While the project is in Overview Mode, click the music + Button at the top of the canvas.

Prewiew Help

Edit Insert

Arrange View

Overview

01

0
L =
STRAWBERRY =E
FESTIVAL .
=1
Main Page

Repeat 1 time(s) Total playing time 0:45

Local Delivery

Storefront
135
02

Specials
Repeat 1 time (%) }Tutal playing time 0:45

[IIjl
LA |
Wi

Repeat 1 time (%) |Totai playing time (115
]

I
g
LT

Price List

Save ¥ @ Login ~

= Repeat L] RepeatOne

BenQ X-Sign 2.0
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2. Choose the mp3 file from your hard drive and click Open.

3. You can replace or delete the mp3 file by selecting the following:

o
X Add music u
@O'“,« - - .. - v‘v‘,HSesr\:ﬁ!CDﬁCﬁi ,O|
Organize « Mew folder =« [ ®
i Downloads * MName . # Title Contributing artist *
5] Recent Places |4 IracklZ.mps 12 Irack 12 Sound ldeas
14| Track13.mp3 12 Track13 Sound Ideas
- Libraries 14 Track14.mp3 14 Track14 Sound Ideas
@ Documents || Track15.mp3 15 Track15 Sound Ideas E
J Music 14| Track16.mp3 16 Track16 Sound Ideas
[ Pictures & Track 17.mp3 17 Track17 Sound Ideas
B videos |4 Track 18.mp3 18 Track 18 Sound Ideas
|| Track19.mp3 19 Track19 Sound Ideas
1M Computer | 14| Track 20.mp3 20 Track 20 Sound Ideas
g Local Disk (C:) ¢ Track 21.mp3 pa | Track 21 Sound Ideas
 Data (D¥) |4 Track 22.mp3 22 Track 22 Sound Ideas
@ BackupData [W\E || Track 23.mp3 23 Track 23 Sound Ideas -
&3 Common META ™ ¢ | I I ’
File name: Track 20.mp3 [ Music ile (.mp3) v
I Open I [ Cancel ]
- ]

File Edit Insert Arrange View Prewiew Help Local Delivery
+ B

Overview [ﬂ Preview @ Save ¥

Storefront

=" Repest ] RepestOne

1:35
01 02
o o= EEEE
STRAWBERRY T
FESTIVAL . = el b
-~ CAKE == L3 =I iR
e 4 i B maw  mm
- .'f_ﬁ T RS B
£ o =5 S5 RE pRINK
Main Page Specials Price List
Repeat 1 time(s) Total playing time 0:45 Repeat 1 time(s) ‘Tntalplayingtirneﬂ:d.ﬁ Repeat 1 time(s) |Tutai playing time( 115

A. Replace - You can replace the audio file by clicking on the file name and selecting another file
from your hard drive.

B. Delete - You can delete the audio file by selecting the Trash icon.

o The audio file will play on a continuous loop for the entire duration of all the pages.
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How to change the playing order of pages

Once all your project pages are completed in X-Sign Designer 2.0 you can change the playing order

for the final content.

To change the page order of a project:

I. Select the Overview button to see the page layout of the project, the order page icons repre-
sent the playlng order for the project.

Overview

Prewiew Help Local Delivery

IB Preview

@ Save «

@ Login =

01

STRAWBERRY
FESTIVAL

Main Page
Repeat 1 time (%) | Total playing time 0:45

2. Select the page icon you want to move and drag it left or right to the desired position.

01

STRAWBERRY
FESTIVAL

-

Main Page
Repeat 1 time(s) fTotaIpIayingtimeD:tls

Storefront
1:35

02

Specials
Repeat 1 time () |Tma| playing time 0:45

Prewiew Help Local Delivery

Storefront
1:35

Specials
Repeat 1 time (%) ‘Tmal playing time 0:45

fitT e

jeun
i

]

4

b
san
Fi11

,.,
z
m

H ]

Price List

Repeat 1 time(s) | Total playingtime(1)5

E] Preview

Track 21.mp3 m

MACARDN

S

Price List
Repeat 1 time (%) |Totalpiayingtirner!15

= Repest

Save ¥

= Repeat

BenQ X-Sign 2.0

0] Repest One

@ Login -

L] RepeatOne
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How to activate an Interactive function in Standalone mode

Once you have purchased an Standalone Premium License, you can configure your display. The
following is an introduction for activating an Interactive License in X-Sign Player.

To activate your Interactive License in X-Sign Player:

I. Launch X-Sign Player.

2. Press ESC in Windows or select MENU on your remote control to bring up the menu bar.
3. Choose Switch Mode.

Play from File

Settings

Switch Mode

[ 1

About

Quit

4. Select Local Delivery And Interactive function, then select Import License.

Switch Mode

@ standalone(USB)

Local Delivery mode: License is not paired yet.

Interactive function: License is not paired yet.
The source of content is from Designer.

Device Name: Unassigned
Hardware Token: 94:de:80:11:60:2a

Local Delivery
And Interactive function

Import License

Manager
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5. Enter your Interactive License code and select Confirm.

Import License

Please input the license code(16 digits)

*Please make sure the Internet connection is available.

Confirm

Back

6. Select OK in the Success pop-up window.

Success

Configuration has been applied.

7. On the Local Delivery And Interactive function page, you can see that the device’s license
has been paired.

Switch Mode
Local Delivery mode: License is paired.
Interactive function: License is paired
The source of content is from Designer.
Standalone(USB)

Device Name: ETA-095-Win7-EN
Hardware Token: 94:de:80:11:60:2a

© Local Delivery
And Interactive function

Manager

Close

o To play an interactive file via USB, you have to change Switch Mode back to Standalone(USB).
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How to generate a QR Code

I. In X-Sign Designer 2.0, click on the icon EE to add a QR code, and you will be prompted to
enter the URL corresponding to the QR code.

Edit mode
Widgets
Clock ‘Waathar
Video Slideshow  Image Slideshow
® |
EES
QR Code Web
&
RSS Data Connection
)
Text Slideshow  Calling Systam
You
L) 4=

1920 x 1080

X:-297

Generate QR Code

2 New Page (1) - +

x| Iz
Layer

@ object 1 (QR Code)

QR Code

Name object 1

X 804 I v 314
Width 300 . Height 300
Rotate 0 =

Y:678 W:300 H:300 - + 42% - I

Please enter the link address:

hitp(s)://

Confirm Cancel

2. Click on the icon EE to add more QR codes. You can drag the QR code anywhere in the
template. You can also edit the QR code or the link in the editing area on the right panel.

66  BenQ X-Sign 2.0

% |= |
Layer >
Property -
QR Code -

Name object 1

X 804 ¥ 314
Width 300 Height 300

Rotate 0

Transpa.. 9

Content ¥
Edit Link

QR Code
Analysis



3. When you play the content with Manager mode, check QR Code Analysis box and you can
see QR Code analysis on X-Sign Manager.

L 2 -
Layer »
Property -
QR Code -

Name object 1

X 804 _ ¥ 314

Width 300 - Height 300

Rotate 0 i

Transpa.. ]

Content bt
Edit Link

QR Code
Analysis

4. Read more about QR codes on How to see the QR Code analysis report on page 93.

o * Each added QR code has its own carousel controls to be edited independently from others.

* QR code can contain up to 256 words.

How to add a data connection

|. Before adding a data connection to BenQ X-Sign Designer, create the data in Google sheets.

= Movie chart O
File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive

& e ~ T NS % .0 00 123- Anal - 1 - B I S A. %.H- E-l-l
A B C D E [ G H
1 Sunday Monday Tuesday Wednesday Thursday Friday Saturday
2 8:30~10:30
3
4 10:40~12:40
5
6 12:50~14:50
7
8  15:00~17:00
)

10 17:10~19:10
12 19:20~-21:20
14 21:30~23:30

16 23:40~-01:40
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2. Select File and choose Publish to the web.

H File Edit View Insert Format Data Tools Add-ons Help
Share ) 00, 123 Arial - 10
Jx New
C D
Open...
1 [ .
2 Rename...
3 Make a copy...
4
- B Moveto...
5 B Move to trash
7 Import...
8
9 Version history
10
11 Download as
12 Publish to the web. .
13
7 Email collaborators..
1R Email as attachment

3. Make sure the file is saved in CSV format.

Publish to the web

This document is not published to the web

Last edit wa

B 7

-
-

A

m

Make your content visible to anyone by publishing it to the web. You can link to or
embed your document. Learn more

Link

Entire Document 5

» Published conter

Web page

Comma-separated values (.csv)
Tab-separated values (.tsv)
PDF document (.pdf)

Microsoft Excel ( xlsx)

OpenDocument spreadsheet (.ods)

More -

2

o It may take about five minutes for Google data to synchronize with X-Sign Designer.
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4. Click on the icon ngj to add a data connection, and you will be prompted to enter the Input

Web URL corresponding to the data in Google sheets. Then enter the information for the
column, row, and update frequency. You can create the data connection with one single table
instead of creating a cell one by one.

Data Connection settings

Source URL:  http//

Column From: 1 Column To: 10 *1~10
Row From: 1 Row To: 10 *1=10
Update Freq: 600 secs

Confirm Cancel

5. You may set the properties in the editing area on the right panel.
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How to set a weather widget

I. In X-Sign Designer 2.0, click on the icon %> to add a weather widget, and you will be prompted
to place the weather widget.

Edit Insert Arrange View Prewiew Help Local Delivery
v
. 3 New Page (1) - -+ % | = | ~
Widgets Layer
Property
G | & i
Clock Weather
Name abject 1

X 821
-
Video Slideshow Image Slideshow
Transpa.. — ——
EE Content
B E]
R Cod: Web
QR Code el Display Format ~ Tod:
Color
&
RSS Data Connection

(@ syncwith X-Sign b
2. Click on the icon > to add more weather widgets. You can drag the weather widget
anywhere in the template.

3. You may set the properties of each weather widget. You can set the title layout, text color, and
background color.

. X[ = -
Layer >
Property -
Weather -

Name object 1

X 1,048 7 ¥ 386
Transpa..  J
Content =
Display Format ~ Today (vertical) -

@ Sync with X-Sign Manager
(O Manually Select

AQl
Information I:‘

-+ a2% « 31 L—Pm d

1)

Background

n Color #CDDBFF

D

13°C
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4. You can also change the display format.

Layer
Property

Weather Today (vertical)

Hame objet Today (square)

X 5 Today (horizontal)
Three days (vertical)
Transpa.. =
Three days (horizontal)
Content Five days (vertical)

Display Format ~ Five days (horizontal)

Color | #FFFFFF

@ Sync with X-Sign Manager
(O Manually Select

5. To set the city, first identify the city in the device management section of the online X-Sign
Manager. You can check Sync with X-Sign Manager to sync the city information with the
device on X-Sign Manager, or you can check Manually Select to select the city yourself.

How to set a timer widget

I. In X-Sign Designer 2.0, click on the icon (T} to add a timer widget, and you will be prompted to
place the timer widget.

Edit Insert Arrange View Prewiew Help Local Delivery

- 3 New Page (1) - + ® | ) | G
Widgets Layer
ey (&) Property
Clock Weather
Page
New Pz
Name
Video Slideshow Image Slideshow Duration 10:00.C
EE @ Resolution 1920x1
[=ES
QR Code Web Panel Area 1x1
Background
& —
RSS Data Connection Coioy
Image
Ta
i Ac
Text Slideshow Calling System
Image Style Non
You (\:_)
Transitions
YouTube Timer
1920 x 1080 X:1528  ¥:1272 - o+ 4% -

Effnns Rl

2. You can drag the timer widget anywhere in the template.
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3. You may set the properties of the timer widget in the editing area on the right panel. You can
switch the count mode to Countdown and Count up. You can also switch mode to Calendar
Mode and Repeat Mode.

Settings - Settings v
Function Countdown - Function Count up -
Mode Calendar Mode o Mode Repeat Mode -
sartbate | 2018/03/26 | | 2018/03/26 |
Start Time 08:00 A Start Time 08:00 ~
Edbae | 2018/03/26 | | 2018/03/26 |
End Time 08:30 > End Time 08:30 hd

4. Countdown shows a sequence of backward counting to indicate the time remaining before
your scheduled end time.

Settings o
Function Countdown *
Mode Calendar Mode x
swtose | 2018/04/20 |
Start Time 12:00 ¥
Edpse | 2018/04/20 |
End Time 12:30 ¥
Appearance >

5. With Calendar Mode, you can select start time and end time. Open calendar by clicking the
start time or end time button. Click Confirm to finish setting.

z Layer »
< April 2018 > property .
Sun Mon Tue Wed Thu Fri Sat Rotate 0 =

Transpa.. ——

Settings -

B i . 54 - n 5 Function Countdown %

22 23 24 25 26 27 28 Mode Calendar Mode -
29 30
stoae || 2018/04/20 |
Start Time 12:00 b
Confirm Cancel
Endpate | | 2018/04/20 \l
End Time 12:30 b
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6. Countup shows the adding of time. It starts at 0:0 (minutes: seconds) and counts up to your

scheduled end time. With Repeat Mode, the counting will occur everyday between the start
and end time repeatedly.

Settings .
Eimoton Count up v
Mode Repeat Mode o

wiose | 2018/04/20 |
StartTime  12:00 >

[ 2018/0420 |

End Time 12:30 ¥

7. You can change the display format (Minutes/Seconds or Minutes) and layout (A or B).

Appearance -
0 0 5 0 0 Display Format ~ Minutes/Seconds >
Min Layout Layout A =
Settings >
Appearance -
Display Format ~ Minutes 7
Layout Layout B 7
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How to manage the calling system

I. To manage the calling system, select Advanced Application > Queuing System.

Ayailable space : 99 GB
R S——

' Device

*  File Management

' My Favorite

' Report Analysis

~ Advanced Application

Queuing System

Please select the control Panel or add a new one:

LY
[

me O
WorkShop

Queuing System

o

Warning Letter Settings

*  License Management

About

me O

writerdemo

Unbound any equipments

2. Click the panel to manage the calling number.

me O

Poste Monoco

Queuing System

Please select the control Panel or add a new one:

ment

SIS
plication

stem

fter Settings

agement
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3. Enter the corresponding number on the queuing widget in X-Sign Designer for the panel and
click Next.

2018/3/30 5:35:00PM =

1 R % Current Number
1 2 3
4 5 6 126
7 8 9
0 Enter

4. The current number to the panel is shown on the screen.

S Current Number

127

Next
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5. You can also edit the number by clicking other function buttons = ==

2018/3/30 5:42:26PM =

Mumber Restart

Setting number
period

\Nun

Shortecut

Logout

6. To restart the queuing number, select Number Restart and click OK.

Are you sure restart queuing number?

7. The queuing number is restarted.

9 Current Number
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8. To set the period for the next queuing number, select Setting number period, input the
number, and click OK.

Please input the number for period of next queuing number.

E

Cancel

9. The number period is set.

Update success

10. Select Shortcut for more information about how to add a shortcut to the desktop.
I'l. To log out, select Logout and click OK.

Are you sure logout?

Cancel

o “Equipment status error” message occurs when the equipment is not online.

Equipment status error, please checked.

* Android_Box_W
* AlbertPC
* Barcelona

confirm and continue.
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Local Delivery

How to play content with Local Delivery

With X-Sign Local Delivery, you only have to connect your PC (Designer) with BenQ Smart Signage
in the same subnet. Then you can play and schedule the content with the device(s) without other

servers or Internet.

o The maximum number of devices that can be played by Local Delivery is 16.

I. Switch to Local Delivery And Interactive, then press Close. Refer to How to upload your
content from Designer on page 20 for more information.

Switch Mode

Standlone(USB) mode
The source of content is from local or USB

@ Standlone(USB)

Local Delivery
And Interactive

Manager

Close

2. Make sure your PC and displays are in the same subnet. Open X-Sign Designer on your PC.
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3. You can press Local Delivery on the main page or on the top function bar.

%) X-Sign Designer - New Project

(S
Fille  Edit  Inset  Awange  View  Prewiew  Help  Local Delivery
—

. AN
' s o HEN
Om 5 = |
Open Project New project Interactive template Local delivery

-

Demo Video

4. On the Devices page, you will see all devices which are in the same subnet and in Local
Delivery and Interactive mode.

Z Change the name for the display.
@ : Pause current playing content of the device.

E : Device screen has the flash effect to let you distinguish which device is being used now.

Devices
] DEvicEs
. £ ©® &
Mame = P MAC Address Channel Status
BenQ IL490 1921680114 18:6571:38:36:49 demo_room_IL [ ]
BenQ STS50K 192.168.0.114 A0:8b:76:44:54:22 @

2. CHANNELS

B USB DELIVERY

5. Before setting schedule and playing content, you must add the device into the channel.
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6. Go to CHANNELS, then press Add Channel.

7.

80

Channels
] DEvices
Add Channel
Name = Mumber of devices Description
test 1
soa CHANNELS test2 0
test3 0
demo_room_bartype 1
demo_room_IL 1

3 USBDELIVERY

For creating the channel:
A. Enter the basic information of the channel.

B. The device list is already in the channel.

C. Add a new device into this channel.

Channels > Add
[ DEVICES
A Name
ae Description
4
@) Add Device
ssa CHANNELS
Name « P MAC Address Status

B2  USB DELIVERY

Confirm Cancel
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8. Select the device you want to add to the channel, then press Confirm.

Channels > Add > Add Device
— ] DEVICES
Name = P MAC Address Channel Status
2. CHANNELS BenQ IL490 7C13F7EC-E710-467F-84A9-..
+| BenQST550K 192.168.0.114 40:8b:f6:44:b4:22 ®

B3  USB DELIVERY 8 Beng STZS0K

dccZjackyhsieh

Confirm

b0:c5:cc:70:02:9f

02:00:27.00:00:15

Cancel

A device which is already added to one channel can't be added to another channel. You have to remove it from its

channel first.

9. You can also press [ || to remove devices from the channel.

Channels > Edit

DEVICES

Name test

Description

Name

T CHANNELS
=
BenQ STS50K

BenQ ST650K

B2 USB DELIVERY

P

192.168.0.114

Confirm

(X Com )

@
MAC Address Status ‘
40:8b:f6:44:04:22 ® ‘

b0:cS:ca:70:02:a4

Cancel

10. After the channel is created successfully, you can control channels as below.

m : Set Schedule for the channel.

/f : Edit the channel for the basic information and the devices in it.

@ : Pause the current playing content of the channel.
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! : Delete the channel.

Channels

DEVICES
- Add Channel B £ ®

Name » Number of devices Description

test 2

;2. CHANNELS test2 0

-
test3 0
demo_room_bartype 1

d I 4
B0 USB DELIVERY lemo_room.|

I'l. Press D and you can set schedule for the channel.

* Add Schedule: Create a new schedule for the channel. You can also double click the time table
to create it based on the time you choose.

* Import Schedule: Import the Standalone(USB) mode playable file to be the schedule for the
channel.

Channels > Schedule

[] DEVICES |
Add Schedule : import Schedule I
08 am

2=, CHANNELS

2 USB DELIVERY

12. After pressing Add Schedule, you can start to set the schedule.
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A. Choose the project you want to play in the schedule. Press ™ and you can see the recent
file. Press Browse to select the file from the file explorer.

Channels > Schedule > Edit
DEVICES
:l Add Schedule
Schedule name test
Remove
Deliver File f Browse
2. CHANNELS B erealinki226
Time L End AM11:30 W
==
&=
& 2 nneerteet
e
B3 USB DELIVERY =l
123
-
n.ﬁ DemoRoom_IL
e
Local v Save Cancel
B. Set the time for the schedule.
Channels > Schedule > Edit
DEVICES
D Add Schedule
Schedule name test
Remove
Al | oever e arealink1226 - Browse
xr=
22 CHANNELS
B, [nme AllDay  Start AM 11:00 - End AM11:30 -
2
2 USB DELIVERY
Local delivery Save Cancel
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I3. You can also press Remove to remove schedule from the channel.

Channels > Schedule > Edit
(] DEvICES
Add Schedule
Schedule name test2
Remove
Deliver File 123 w Browse
=]
som CHANNELS
Time All Day Start  AM 06:30 v End AM 07:00 -
Schedule name test
Remove
B  USB DELIVERY Deliver File arealink1226 - Browse
Time All Day Start AM 11:00 v End AM11:30 -
Local delivery Save Cancel

I4. You can set multiple schedules in the channel. After you finish the setting, press Local Delivery
to deliver the schedule content to all devices in the channel.

(Cx oz )

Channels > Schedule > Edit

DEVICES
=

Schedule name test2
Remove

Deliver File 123 b4 Browse
22, CHANNELS

Time All Day Start  AM 06:30 A4 End AM 07:00 v

Schedule name test
Remove

B USB DELIVERY Deliver File arealink1226 . 4 Browse

Time All Day Start  AM 11:00 - End AM11:30 A4

Local delivery Save Cancel

I5. Now devices in the channel will start to play content based on your schedule.

84  BenQ X-Sign 2.0



How to search for devices in Local Delivery Mode

Local Delivery allows different displays to be connected over the same local network. This is an
introduction to viewing devices in Local Delivery Mode.

To open Local Delivery Mode:

I. Launch X-Sign Designer 2.0 and select Local delivery.

File Edit Insert Arrange View Prewiew Help. Local Delivery

. | =eEmsl TS

Open Project New project New Interactive Project Local delivery

O

Demo Video

o If X-Sign Designer 2.0 is already open, you can select Local Delivery > Local Delivery from
the top menu.

2. The Device window will appear showing all the local devices currently connected to the

network.
Devices
(] DEviCES
Name = P MAC Address Channel Status
BenQ IL490 192.168.0114 18:65:71:38:36:49 demo_room_IL [e)
CHANNELS BenQ ST550K 1921680114 40:8b:6:44:b4:22 @

B STANDLONE(USB)
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3. Select the device you want to edit from the list and then select any of the following items.

Devices A B C
Z1O1E
Name = IP MAC Address Channel Status
BenQ IL490 192.168.0.114 18:65:71:38:36:49 demo_room_IL (&)
BenQ STS50K 192.168.0.114 40:8b:f6:44:b4:22 [&]

A. ,_' — Click this button to bring up the device name window. Click the text and enter the new

name for your device.

B. @ — Click this button to pause the content on the current device.

C. [2] - Click this button so that the device will flash a black screen. This function will help you

identify a specific display when multiple devices are connected to the local network.

How to set a schedule for Local Delivery Mode

When operating several devices in Local Delivery Mode, you can set different schedules for each
display to broadcast content. Devices are first added to a channel and then a schedule is set for that
channel. Below is an introduction to setting a schedule in Local Delivery Mode.

To create a channel in Local Delivery mode:

I. Launch X-Sign Designer 2.0 and select Local delivery.

File  Edit Insert Arrange View Prewiew Help  Local Delivery

B - | mmm 'J"
i . =222\

Open Project New project New Interactive Project Local delivery

O

Dema Video

o If X-Sign Designer 2.0 is already open, you can select Local Delivery > Local Delivery from
the top menu.
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2. In the Device Window click CHANNELS, then click Add Channel to create a new schedule.

Close

Channels

DEVICES
- Add Channel

Name = Number of devices Description

Afternoon Sale 0 Weekday Sales Info

CHANNELS

B STANDLONE(USB)

3. In the Add Channel window you can select the following:

Channels = Add

AlName - Afternoon Sale |

B |Desr.:r'sptiun . Weekday Sales Info |
AddDevice @ D |
Name = P MAC Address Status
BenQ STS50K 192.168.0.114 40:8b:f6:44:b4:22 [ ]
BenQ ST650K b0:c5:ca70.02.a4
Confirm Cancel

A. Name — Enter a name for the channel to be broadcast.
B. Description — Enter a description for the channel to be broadcast.

C. Add Device - Click Add Device to add displays to this channel. In the pop-up window
select the checkbox next to the device(s) you want to add and click Confirm.

D. 'uLj — Select the device you wish to delete from the channel and click this icon.

4. Click Confirm to create the channel and click OK.

BenQ X-Sign 2.0
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To set a schedule for a channel in Local Delivery mode:

I. In the CHANNELS window, select the channel you want and click the D button to add a
schedule.

Channels

Add Channel IEI L O @

Name = Number of devices Description

Afternoon Sale 0 Weekday Sales Info
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2. Click Add Schedule to create a new schedule for the channel.

Click Import Schedule, to import a schedule from a previous project, then find the xplan file
on your hard drive and click Open.

Channels = Schedule

00 am

DZam

06 am

DB am

3. In the Add Schedule window you can select the following:
Channels > Schedule > Edit

A Weekday Sale G Remove
B Storefront v Browse C

Time Start  PM 07:00 v End PM 05:00 v

A. Schedule name — Enter a name for the schedule.
B. Deliver File — Select w# button to choose a saved project from the dropdown list.

C. Browse — Choose a X-Sign Designer project from your local hard drive.

D. All Day — Click the box to broadcast the content for 24 hours.

E. Start - Select w button to choose a broadcast start time from the dropdown list.

F End - Select # button to choose a broadcast end time from the dropdown list.

G. Remove — Click to remove this schedule from the channel and then click Yes from the pop-
up window to confirm.

BenQ X-Sign 20 89



4. Click Local delivery to deliver this schedule to the assigned devices in the channel. Select Save
to save this schedule to this channel.

Channels > Schedule > Edit

Add Schedule

Schedule name Weekday Sale

Remove
Deliver File Storefront - Browse
Time All Day Start PM 01:00 - End PM 05:00 -
Local delivery Save Cancel
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Report

How to get the device information remotely

I. To access the device information of X-Sign Manager remotely, go to Report Analysis >
Remote Monitoring Report.

2. Select device and choose start time and end time, then click Export.

w Available space : 99 GB

+ Device

*  File Management

v My Favorite

' Report Analysis

Interactive Report (Beta)

QR Code Analysis

Remote Monitoring Report

X-Sign Manager Report

v Advanced Application

' License Management

About

Remote Monitoring Report

Select Device

STE50KL
StatTime | e | 5013.03.02
End Time 8 2018-0329
Export

3. The device information is exported as an .xls or an .xIsx file type.

4l - e || Time Stamp(GMT +00:00)
A B C D E F G H I J
1 |Time Stamp({GMT +00:00) |Player Version Total Storage Disk Used  Disk Free CPURate Total Memory RAM Usage
2 |2013-03-22 08:31:56 2.0.8.5 4.0GB 582MB 3.4GB '3% 1.3GB A442MB
3 52018—03-22 09:31:56 2.0.8.5 4.0GB 582MB 3.4GB '4% 1.3GB A43MB
4 !2018—03-22 10:31:56 2.0.8.5 4.0GB 582MB 3.4GB '2% 1.3GB 443MB
5 52018—03-22 11:31:56 2.0.8.5 4.0GB 582MB 3.4GB '1% 1.3GB A43MB
6 !2018—03-22 12:31:56 2.0.8.5 4.0GB 582MB 3.4GB T'I‘Pﬁ 1.3GB A442MB
7 52018—03-22 13:31:56 2.0.8.5 4.0GB 582MB 3.4GB '0% 1.3GB A43MB
3 !2018—03-22 14:31:56 2.0.8.5 4.0GB 582MB 3.4GB '.5% 1.3GB 443MB
9 52018—03-22 15:31:56 2.0.8.5 4.0GB 582MB 3.4GB '21% 1.3GB A46MB
10 !2018—03-22 16:31:56 2.0.8.5 4.0GB 582MB 3.4GB T'I‘Pﬁ 1.3GB A447MB
alal 52018—03-22 17:31:56 2.0.8.5 4.0GB 583MB 3.4GB '3% 1.3GB A43MB
12 !2018—03-22 13:31:56 2.0.8.5 4.0GB 583MB 3.4GB '2% 1.3GB A44MB
12 52018—03-22 19:31:56 2.0.8.5 4.0GB 583MB 3.4GB '1‘3% 1.3GB A44MB
14 !2018—03-22 20:31:56 2.0.8.5 4.0GB 583MB 3.4GB T'I‘Pﬁ 1.3GB 441MB
15 52018—03-22 21:31:56 2.0.8.5 4.0GB 583MB 3.4GB '5% 1.3GB A42MB
16 !2018—03-22 22:31:56 2.0.8.5 4.0GB 583MB 3.4GB '3% 1.3GB 441MB
17 52018—03-22 23:31:56 2.0.8.5 4.0GB 581MB 3.4GB '1% 1.3GB A41MB
13 !2018—03-23 00:31:56 2.0.8.5 4.0GB S581MB 3.4GB '1% 1.3GB 441MB
19 52018—03-23 01:31:56 2.0.8.5 4.0GB 581MB 3.4GB '2% 1.3GB A41MB
20 !2018—03-23 02:31:56 2.0.8.5 4.0GB S581MB 3.4GB '.5% 1.3GB 440MB
21 2018-03-23 03:31:56 2.0.8.5 4.0GB 582MB 3.4GB '2% 1.3GB A41MB
r
| RemoteMonitoring2018-03-29 | @ o
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How to get the activity report of X-Sign Manager

I. To access the activity report of X-Sign Manager, click X-Sign Manager Report.

2. Choose start time and end time, then click Export.
fvajlahlesp_aee:QQGB

X-Sigh Manager Report

*  Device

* File Management

' My Favorite

* Report Analysis

Interactive Report (Beta)
QR Code Analysis

Remote Monitoring Report

X-Sign Manager Report

' Advanced Application

' License Management

About

Start Time

End Time

# | 2018-03-12

8 | 2018-03-19

3. The activity report is exported as an .xIs or an .xIsx file type.

Al | fr | Time Stamp(GMT +00:00)
A B C D E
1 |Time Stamp({GMT +00:00) levent Account({Authority) Action Detail
2 |2018-03-15 05:59:45 Device Activity Albertkang(Administrator) Remove Device(|W_PC){5FRQ6Z50Q)
3 |2018-03-15 05:5%:59 Device Activity Albertkang(Administrator) Remove Device(WPC)(BNJBGYCR)
4 |2018-03-15 06:02:04 Device Activity Albertkang(Administrator) Add Device{demoroomwriter){8MVRSPHZ) with City(Taiwan) Channel{Uncate
5 |2018-03-15 06:34:46 File Activity Albertkang(Administrator) Upload File Name(test03333333)
6 |2018-03-15 13:02:21 Device Activity Albertkang(Administrator) Remove Device(11f){DHFFGB7P)
Fi
8
9.
10
13
12
13
14
15
16
17
18
13
20
21

[ XSignManagerLog2018-03-19 |
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How to see the QR Code analysis report

I. To see the visualization of the clicks, 0s%, or browser%, click QR Code Analysis.

8 Available space : 89 GB

* Device

QR Code Analysis

*  File Management

» My Favorite Name = Web address

*  Report Analysis

Interactive Report (Beta] 5 DHF_DEMO001 bd
TR R ):X-Slgn 105{;192‘,) P https:i/x-sign.beng.com/
| QR Code Analysis |
Emote Monionng Hepol
X-Sign Manager Report ' . 1F demo room DH_ "
)‘ X-Slgn 1080x1920 https:/fx-sign.beng.com/

*  Advanced Application

*  License Management

https:/hwvew. kfc.com/

About

1920x1080

): X-Sign hew Schedule B hittps:/havan. kfc.comi

): X-Sign babtybugerkde http:/www. promotion bobby

1920x1080

Overview

| Overview |

| overview |

| Overview |

Overview |

| Overview |

Statics

| DH_back |

| DH_back |

| sTE50KL |

| sTesoKL |

| ST5E0KL |

o2 Account Management 8 Albert

Search

Upload time

2017-04-06 18:16:15

2017-04-07 12:44:14

2017-09-20 15:37:32

2017-09-20 17:12:37

2017-09-21 10:36:32

o Before clicking QR Code Analysis, you need to enable the function in X-Sign Designer first, then scan the QR

code to get the data. See How to create a new project file in X-Sign Designer on page 42 for more information

about how to add a QR code.

2. Click Overview and the button under Statics.

o~ Account Manage

Code Analysis

Name = Web address

DHF_DEMOQO001.bd :
):X-Sign 1080x1920 ¢ https:/fx-sign. beng.com/

1Fd DH..
): X- Sign lDE—C\exnl";er;mm https:/x-sign.beng.com/

d land.bd
):X—Sign lz:g&:go B https:/iwww. kfc.com/

Overview Statics
Overview | | DH_back
| overview | | DH_back |
| Overview | | STB50KL

Uplo:

2017

2017

2017

BenQ X-Sign 2.0 93



3. You can see the charts indicating the clicks, os%, or browser%.

Overview x DH_back x
Lot [ | v | o | rrs =
M Click times All time 5
s Month 0
Week 0
4
Day 0
3 Two Hours 0
2
|
o

DH_back Browser percentage 0S percentage

ON@

Ciose
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Interactive

How to create interactive content with Interactive template

X-Sign Designer Interactive template can help you create interactive content in a few steps. It will be

the best solution for BenQ smart signage IL series (with touch function).

I. Launch X-Sign Designer, then choose Interactive template.

File  Edit  Insert  Amange  View  Prewiew  Help

- 'y\\,
~ah
5 o LT
| samn| | gl
= | . =—
Open Project New project Interactive template Local delivery

Local Delivery

O

Demo Video

2. Choose the template style you want to use. Set the name and path for the file, then press

Confirm.

_- D:\Users\Bobby.Y.Chen\Documents

File name

b
i Denim
& Y1 Collection

WOMEN

s
KIDS

l test|

Jam 2

AL

“‘ﬂf. LT o

ma % 1
VER e

Confirm
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3.

4.

Press Map View, and you can see the structure of the template.

Edit Insert Arrange View Prewiew Help Local Delivery

Edit mode = Map View [®] Preview @ bobbychen

- |9 = ~
Layer *
@ T build-in (Text)

Basic Tools

Denim
Collection ® T buildin (Text)

Up to 50% off ® build-in (Category Generator)

© (@ build-in (Image)

O WOMEN
! co more . :

Category Generator >

MEN

Layout =1

Layout 1x1 -

‘. Spacing
KIDS ) =
e 40

1080 x 1920 X:-1138  Y:-227 W:1080 H:1312 -+ 3% -

Below are the basic functions of Map View.

A. Choose the page and you can see the preview on the left side.
B. Choose Edit to go to Layout page (Level X) to change the layout.
C. Choose the page and you can see related subpages.

D. Hold down the page then drag and drop to change the page order. Double click to go to the
content page (LX) directly to edit.

* There are three layers’ structures:

96

Level I: Main page
Level 2: Category
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Level 3: Item/ Product

X) X-Sign Designer - D\Users\Bobby.Y.Chen\Dacume

e

WOMEN

Classe hnny s

< a

Ad page

Level 2 Edit.

€

Wool cap Classic skinny jeans  Vinttage denim jacket

%] X-Sign Designer - DAL

Classic Whae Tt

Vintaga dervmjschet

WOMEN

LT =
& 1

Classic skinny jeans

Vinttage denim jacket Vintage boyfriend jeans Basic T-shirt Lace dress
'!b- ’lhl Nwx
‘- 1 & 0
Black lace top Black skinny jeans Basic tank top Leather skirt

= a
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5. On Layout page (Level X), click Category Generator to change the layout.

%) X-Sign Designer - DAL 'Chen\D enexml * - o ®
File Edit Insert Arrange View Prewiew Help Local Delivery

K Edit mode = Map View [] Preview Save v @ bobbychen ~

/ test Levell - e = -
Basic Tools A i Layer -

5 ® T build-in (Text)
Denim

Collection @ T build-in (Text)

Up to 50% off ® build-in (Category Generator)

@ @ buildin (Image)

T ]

Text Image

o O

Video Rectangle

O WOMEN
Oval £ e 3
\| I Property v
| Category Generator .

Name

X 0 ¥ 608
MEN
Saciin Opacity _—

Layout -
Layout T

Spacing

KIDS

1080 x 1920 X:2452 Y:1806 W:1080 H:1312 -+ 3% + =

6. On Content page (LX), double click Import images to import the content to Category
Generator.

X_Close
I Import images I TouchReport | Select All
Order Image Title Subtitle Touch report Edit visible arza Delete

WOMEN

= P WOMEN See more Cd Description 1 £ a

2 ‘ MEN See more v Description 2 A a8
MEN

3 '5 KIDS See more v Description 3 £ a
KIDS

7. Below are other functions of Category Generator.

A. Change the order of the items. Drag and drop the item to change the order.
B. Change the image source.
C. Change the display strings here.

D. Enable Touch Report to see the touch analysis report on Manager. You can enable/disable all
by pressing the top-right button.
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E. Set the visible area for the picture of items.

Drag image to moify the visible area

Cancel

F. You can also right click mouse to delete it. Once you delete the item, you also delete related
subpage(s) which can’t be recovered.

G. You can preview the page. You can scroll to see the whole page.

Import images I Touch Report | Select All I D)
Order Image Title Subtitle Touch report t visible b Delete
WOMEN
1 p WOMEN See more 4 Description 1 £ ]
k
2 i MEN See more ! Description 2 £ a8
MEN
3 @ KIDS See more i Description 3 £ a
\ ] J
A B (G D) E B
KIDS r ) ) )
G
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8. The number of items you import into the template will automatically generate the related next
layer.

Import images Touch Report Select All

Title Subtitie Touch report [Edit visible arsa Delete

image
=
1 A Title 1 Subtile1 ¥ Description P e
2 mc Title 2 Subttle2 @ Description2 ‘ =
3 .l s I Title 3 Subtitle 3 v Description 3 £ [ ]

4 T.\a ‘ Title 4 Subtitle 4 v Description 4 £ e

Ad page Level 1 Edit
M —
Denim [N
Collection =® |
Up to 50% ofl Main Page

A
7|
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9. On Layout page (Level X), you can insert a widget. It will apply to all related Content pages (LX).
You can't insert any widgets in Content page (LX) separately.

X

Local Delivery

- %[ i
ill apply to all sub pages with the same level

i

® = object 5(image)

® = buildin (image)

- Rectangle
™ Rectangle

® (3] buildin (Category Generator)

Rectangle

® T buildin (Template Text)

Resolution  1080x1920

Panel Area =
Background
Color sFeFeFa
-— 4 i Image
. i Add Delete
i magestie  Fill -
: Background Audio -

100011920 X:2600 Y972 -+ 4 -

4 w121 - L3 e [

Basic Tools SattingdadbisDageyyll apply to all sub pages with the same level Layer -

. B - EEr——

® @ buikkin image)

® [ Rectangle

. ® O Rectangle
[ -] [

[ buikdin (Category Generator)
Rectangle

T buildin (Template Text)

0

wa_Echpse_1280x72009

1080 % 1920 XU Y32 Wi Hoie -+ M8 - 3

[0. On Layout page (Level X), you can also remove a built-in widget in the interactive template.
Once the widget is removed, it can’t be recovered.
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I'l. On Content page (LX), you can set the content for a built-in widget.

X X-Sign Designer - Di\Users\Bobby.Y.Chen\Documents\trttitititttiscene xml - o x
File £ dmerl  Amwgs  View  Prewiew el Local Delivery

/ Setting in this
e

L3111 b d

Title 1

e

Rectangle
Rectangle
% buidin (image)
= bulld-n (Template image)
@ build-in (Template Image)
Rectangle

T buildin (Template Text)

HESN SN RE SR NN B

L

Termplate image

542 ° 724 ©

—

image C2175162jpg

- Content

1080 x 1920 X632 YN0 WS WM - . 4 - I

12. Enjoy creating your interactive project with our interactive content.

How to create interactive content from designed templates with Area Link

There are two ways to create interactive content in X-Sign Designer.

* Interactive Template: Three layers’ structures designed by BenQ Designer which make you change
your content easily. Refer to How to create interactive content with Interactive template on page
95 for more information.

* Area Link: For you to customize the link relation yourself. You can easily use it to turn the original
project into the interactive project as you wish.

The following is an introduction of how to create an interactive content with Area Link.

Be sure that your smart signage has successfully imported with the interactive content otherwise the touch
function may not work.
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I. Open the project you want to change to the interactive content, then select Overview mode.

K] X-Sign Designer - D:\Users\Bobby.Y.Cher\Desktop\internal release1225\arealink1226\scenexml

Prawiew Help Local Delivery

arealink1226

G Music +

Boutique-Watch-2 1080x1920 Boutigue-Watch-1 1080x1920 Boutique-Watch-3 1080x1920
Repeat ] time(s) = ‘ Total playing time 0:40 Repeat 1 time(s) =~ Total playing time 0:40 Repeat 1 time(s) = | Total playing time 0:24

2. Choose the page you want to set the link, then press Set Link Area.
X X-Sign Designer - D:\Users\Bobby.Y.Chem\Desktophinternal release1225\arealink1226\scenexml|

: Prewiew Help Local Delivery

arealink1226

144 Music

Set Link Area

Link te

Boutique-Watch-2 1080x1920 Boutique-Watch-1 1080x1920
Repeat 1 time(s) =~ | Total playing time 0:40 Repeat 1 time(s) = Total playing time 0:40

i
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3. You will see Link Area setting wizard. Drag an area to create an Area Link.

sphinternal release1225\arealink1226\scenexml
w  Help  Local Delivery

EditLink Area | Boutique-Watch-2 1080x1920

DAPHNE WELLINGT( @

Watches

4. In Area Link configuration, you can set:

A. Set the page you want to link to. After tabbing the area, you can see the related page.

B. Set the link effect. You can go to the link page directly or to the link page overlapping the
original one.

C. Set the transition effect.
D. After you finish the setting, you can preview the effect.

E. Go to and edit other pages.

WDeskiop\internal release1225\arealinki 226\scenexm|

Prewiew  Help  Local Delr

EditLink Area | Boutique-Watch-2 1080x1920 X Close

A\ Set Link To
r= Choose a destination page >

inkType
BJ Go to page -

Cesture

E Tap -
CJ Transitions
—) Cube -

DAPHNE WELLINGT(C

=~ Watches
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5. Set link to the previous page, then you can go back to the previous page.

Link Area | Boutique-Watch-1 10§0% v previen ) (% )

Set Link To

Previous page -

Go 1o page -

Gesture

B -

Transitions

Cover From Right -

6. After you finish the setting, press Save.

7. Now you can enjoy creating interactive content.
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How to view the structure of an Interactive Template

You can use Interactive Templates in X-Sign Designer 2.0 to create interactive projects for your
touchscreen display. The following is an introduction to working with Interactive Templates.

O This feature is for BenQ members who have purchased a Premium License only.

To open an Interactive Template in X-Sign Designer:

I. Launch the software and click New Interactive Project.

File Edit Insert Arrange View Prewiew E Local Delivery

'?’/

- s I

3|

Open Project New project New Interactive Project Local delivery

O

Demeo Video

2. Choose a location on your hard drive to save the project and create a File name. Select the e-
brochure template you want to use and click Confirm.

[ ] C\

Storefront

e-brochure (portrait)

& it :‘ q- SZ

{4 B
ol “'I " .
& pad e

e-brochure (landscape)
S PEETET S

Confirm
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3. You can preview the layout of the Interactive project by clicking on Map View.

File Edit Insert
»

Edit mode

Basic Tools

T )

Arrange

View

Prewiew Help

WOMEN

MEN

KIDS

Local Delivery

Denim
Collection

Up to 50% off

m Preview

Property

Page
Name

Duration

Save -

Levell

0.000

Resolution

Panel Area

Background

1080x1920

1x1

Color |

#FBFBF8 |

4. Each interactive project consists of 3 Levels, and each level consists of a Template Page and
Content Pages:

Q

Whatever

WOMEN

Classic skinny jeans

}

Promotion Page Level 1 Edit
p.
A
[ ]
13
Level 2 Edit
J Jam
A AL
1 : I“I ‘!"
ma.r
L2-2
M=
|
& 1
L3-1-2
M= =

N
L]
& 1

L3-1-3

-

Nie=

N
L}
& 1

L3-1-4

Ne=

A. To preview a specific Content Page, click on its icon on the right side. To edit the selected
Content Page, double-click the icon.

B. To edit a Template Page (which will affect the layout of your Content Pages), click the
Edit button next to the Level you want to adjust.
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5. You can also navigate to each Template Page and Content Page by clicking the « button at
the top of the canvas and selecting the page from the drop-down list.
e e

Storefront Idle

-L1

A:-Ii

<£24

=L

-L2-3

-L3-11

-L3-1-2

-L3-1-3

-L3-14

-L3-1-5

-L3-1-6
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To customize a Content Page in Level 3:

I. You can change each image displayed in a Content Page by selecting it in the canvas, then going
to the Template Image panel on the right and click the ... button.

Storefront

L3-1-1

White Lace Tank top

COLOR: White
SIZE M LKL

PRODUCT DETAILS

MORE INFORMATION

g
.I'E 'F wwi benr, com

-

x = -
Layer »
Property -
Template Image b
336 982 =
260 I 260

Image

Content

level3_image3.png

2. Choose the image you want to use from your hard drive and click Open.

% Select image file:

=)

@Qv| . % Dessert » Dessert-11920:1080 » assets

~[+]

Search assets

ol

Organize +

= Recent Places

- Libraries
3 Documents
J’ Music
=/ Pictures

E Videos

Lo Computer
&, Local Disk (C)
—a Data (D)
# BackupData (W\E
5# Common (\ETA

5 michaelvokins.tt ™

Mew folder

-
1775444677.png

STRAWBERRY
2323359561.png

EgE

3323586278.png

File name: 2678948725.png

FESTIVAL
1088768696.png

2438896119.png

'f"’, |

3538803341.png

2102188116.png

e

35723133%9.png

2678948725, png

2161050546.png

3185256865.png

m

2082011961.png

~ |Imagefiles (*jpg *.png *.gif *b ~
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3. You can change the text displayed in a Content Page by double-clicking it in the canvas, and
then typing in your own text.

Storefront L3-1-1 M " -
Layer ’
Property .
White | ace Tank 100
Template Text .
357)
1
SIZESMLIL = .
] 644 T 355 L
PRODUCT DETAILS Wit 402 T Height 2
Rotat o =
T 4 *
VAORE INFORMATION Content .
ERE
1 -r' wiew beng.com Font Sans Serif Condensed -

i st 29

4. You can edit the URL for a QR code in a Content Page by selecting it in the canvas, then
going to the Content panel on the right and clicking Edit Address. Enter the QR code link
and click Confirm.

Starefront L3-1-1 - " D'
= Layer L]
Property .
White Lace Tank top
il Template QR Code "
DOLOR: White o
SZESMLEL 644 1,070
PRODUCT DETAILS 149 7 Height L
Otate 0 :
....... ®
MORE INFORMATION Content =

[m] o [m]

J B e com Edit Address
D o r
YOU MIGHT ALSO LIKE H

v < A

To customize a Template Page in Level 3:
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I. You can customize the layout of a Template Page for Level 3 by selecting any of the following
items in the canvas:

Storefront Level3 -

Classic White T-shirt

Iw

COLOR: White
SIZESMLXL

MDR@URM.&TWN
[E][m]

1: L www.beng.com
F

=]

A. Template Image — Select the image in the canvas and then customize the settings in the
Template Image panel and the Content panel.

B. Template Text — Select the text in the canvas and then customize its settings in the
Template Text panel and the Control panel.

C. Template QR Code — Select the QR code in the canvas and then customize its settings in
the Template QR Code panel and the Control panel.

2. If you want to delete any Template images or text from the Template page, select the item in
the canvas and press delete. A warning message will appear, click Yes to delete or No to exit.

This component can not be added after the deletion, do you want to
continue?

Yes No
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3. You can add new images, text or widgets to the Template Page by using either the Basic tool

or Widget panel. Click / to access the Basic tool panel or click W to access the Widget

panel. Refer to How to create content in X-Sign Designer on page 45 for more information
about using these tools.

Insert Arrange View Prewiew Help Local Delivery

= Map View [*] Preview Save
- Storefront Level3 - o)l fl vig = -
Basic Tools 1 - Layer »
] mw:nmun ]
B meaaon W Property -
T m Classic White T-shirt Text -
Text Image
Name  Object26
COLOR: White
n D SIZESMLAL X 198 I v e
Video Rectangle Width 220 : Height 61 :
Rotate 0 :
Gl Transpa.. &

For Level | and Level 2 Template Pages and Content Pages, you can add or delete pages, and

customize images and text in the Category Generator window. To access the Category
Generator window:

I. Navigate to the desired Content Page in Level | or Level 2, and then double-click the Cate-
gory window in the canvas.

~ o)X= = -
Layer -
Denim
Collection
Up to 50% off : = :
WOMEN ,
Property >
Category Generator -
Name Sections
X 0 = v 458
MEN Transpa L
Layout -
Layou 1x1 -
Spacing
40 =
KIDS
e e Image Style -
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2. You can edit the following items in the Category Generator window:

Import images Touch Report Check All
|
| On:ierl | Image | | Title | ISuhmlel ITuuch Repunl |§d‘rt wsib\ea(eabe\etgl

WOMEN

1 P» WOMEN See more v Product_1 £

bl

2 é MEN See more v Product_2 £
MEN

3 ."‘"] KIDS See more v Product_3 £
KIDS

A. Order — Click and hold, then drag a category row upwards or downwards to change the order
of the items.

B. Image — Click the image icon and choose a new image from your hard drive. Click Open
when finished.

C. Title — To change the Title text, select the text in the category row and type in your new
text.

D. Subtitle — To change the Subtitle text, select the text in the category row and type in your
new text.

E. Touch Report — Touch Report allows you to track the touchscreen data of specific pages or
categories. Check the box to generate Touch Report data for the category.

F. Edit Visible Area — Click # to change the positioning of the category image.

G. Delete — Click to delete the category and all its sub-pages.
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3. You can add new Category pages by clicking Import images.

Import images | Touch Report Check All
Order Image Title Subtitle Touch Report Edit visible area Delete

WOMEN

1 P. WOMEN See more | Product_1 £ B

H

2 é MEN See more v Product_2 £
MEN

3 "‘-3 KIDS See more | Product_3 £
KIDS

4. Select the image from your hard drive and click Open.

X| Select image file: [ﬂ
@Qv| . < Dessert » Dessert-11920:1080 » assets - |&7 ‘ Search assets L2 [
Organize » Mew folder = + [l @

%l Recent Places  * " - ST FESTIVAL B
1775444677 png 1988768696.png 2102188116.png 2161050546.png
- Libraries —
3 Documents
J‘w Music L
Pict i -
I Pictures STRAWBERRY =
H videos 2323350561.png  2438806119.png | 2678948725.png  3185256865.png
_ o =™
18 Computer E-’ E Ir’ .- s =
£, Local Disk (C) p 1 &)
—a Data [D:) =158 E b
¥ BackupData (\WE .
&% Common (\ETA 3323586278 .png 3538803341 png 3572313399.png 3988911961 png
S michael.vokins.tt T | 2
File name:  2678048725.png - IImageflIes (".jpg ~.png ~.gif b ']
(o | o]

)

5. You can change the Touch Report settings for all categories by clicking *" . Refer to How to
enable Interactive Statistics on page | 15 for more information.
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How to enable Interactive Statistics

For X-Sign Designer 2.0, interactive projects can record the touch statistics of each page within an
interactive project. The following is an introduction to enabling and reviewing interactive statistics.

o This feature is for BenQ members who have purchased a Premium License only.

To enable the interactive statistics for an interactive project:

I. Navigate to the desired Content Page in Level | or Level 2, then double-click the Category
window on the canvas.

Edit Insert Arrange View Prewiew Help Local Delivery

Edit mode ‘ = Map View ] Preview [E) save ~

Basic Tools
Denim ® T buitin(Text)
Collection © T bultin (Tex)

Up to 50% off ® Sections (Category Generator)

® [ built-in (Image)

Video Rectangle

Property =

Category Generator -

MName  Sections

X g v 458

MEN

Transpa.. =@

Layout -

Layout 1x1 hd

KIDS Spacing [ .
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2. Under the Touch Report column in the Category Generator window, select the checkbox
next to each item you wish to track touch data.

Import images Touch Report Check All
Order Image Title Subtitle Edit visible area Delete
WOMEN
_‘\‘.‘ " 1 P WOMEN See more V| Product_1 £ &
2 é MEN See more v Product_2 £ |
MEN
3 "“'J KIDS See more 4 Product_3 £ &
(5>
G
KIDS A
P
3. You can also change the Touch Report settings for all categories by clicking in the Touch

Report drop-down menu. Select Check All to generate Touch Report data for all categories
or select Uncheck All to not generate Touch Report data for any categories.

i Touch Report
Import images ouch Repol Check All
Order Image Title Uncheck All 1 Report Edit visible area Delete

WOMEN

1 F WOMEN See more v Product_1 £ B

H

2 é MEN See more v Product_2 Z [ ]
MEN

3 "‘-g KIDS See more ol Product_3 £ B

KIDS

o To review the interactive statistics, refer to How to view an Interactive Report on page | 17 for more information.
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How to view an Interactive Report

Once you have enabled interactive statistics for an interactive project, you can view the data for your

statistics in X-Sign Manager. The following is an introduction to viewing and reviewing interactive
reports.

To review the interactive statistics for an interactive project:

I. Login to your X-Sign Manager account. Go to Report Analysis > Interactive Report (Beta).

w Available space : 95.7 GB

o Account Management

Device Management

~ Device

I Device Management

Add a new display add category Device Updates
Channel Management » B Device Management - -

*  File Management
Stalus ¥ Name Channel name
* My Favorite

- |
~ Report Analysis I demoroomwriter Unsubscribed

| Interactive Report (Beta) |

sa=_—"
R Code Analysis |y
Q ¥ | Storefront 01 Unsubscribed
Remote Monitoring Report . -;__“_i
X-Sign Manager Report
5 B Demo Room
*  Advanced Application
1 I Asia
* License Management
0 B BQE
About

2. In the Interactive Report (Beta) page you can review statistics using the following items.

Interactive Report (Beta)
C D E F G H
2018-01-31 |m Display type :

Click Export Data v Date from # | 20130101 To

Product  Channel Device

Display item : Product - All

ciicktimes : 2 1 4

. B Click times B Average - 6 9

100
20 |
60 :J' |
a0

20
A
\
\
D+ - d AW

2018-01-01 2018-01-04 2018-01-07 2018-01-10 2018-01-13

2018-01-16 2018-01-18 2018-01-22 2018-01-25 2018-01-28

2018-01-31

A. Type of Report — Click + to choose one of the following data sets to display: Click,
Product, Channel, Category, or Device.
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B. Export Data — Click = to choose an export setting from the dropdown list. You can select

All Data (CSV) to export all interactive data to a csv-file format, or you can select Data in this
page (PDF) to export the data displayed on the page to a PDF.

C. Date From — Choose the start date for the data you want to display in your report.
D. To — Choose the end date for the data you want to display in your report.
E. OK - Select OK to confirm the selections and generate the report in the window below.

F. Product - Select Product to choose the data for specific products (i.e. - categories) you
would like displayed in your report.

G. Channel - Select Channel to choose the data for specific channel(s) you would like displayed
in your report.

H. Device - Select Device to choose the data for specific device(s) you would like displayed in
your report.

118 BenQ X-Sign 2.0



Video Wall

How to set up the environment for video wall

With X-Sign Manager and Player, you can easily set up the video wall environment with BenQ Smart
Signage. You can see the following 1x3 video wall for example.

|. Pair all devices which are used for video wall with X-Sign Manager.

Device Management

+ [ Device Management

DemoRoom_430K

Add a new display add category
Status ¥ Name
<
°® =
3
®
®

Device Updates

Channel name

DemoRoom_430_videowall

DemoRoom_430_videowall

DemoRoom_430_videowall

Search.

Display ID

FDEPXNIX

UBIGHWLL

VRRAXRHS

2. Go to Channel Management to create a channel to add these devices to the channel.

Channel Management

Channel edit

Channel name

Play without schedule

Anti retention

Description

Set Equipments

DemoRoom_430_videowall

picture

X-signBackground.png
Disable

None

ﬂ Delete channel

Add unsubscribed equipments to this channel

Device name «

430L

Display ID

FDEPXNJX

VRRAXRHE

Device version

2083

Category

DemoRoom_430K

DemoRoonm

DemoRoom_430K

Expired date
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3. After the channel is created, select the channel and choose & .

Channel Management

ool
Type ~ Channel name EgE R mount
| Video Wa DemoRoom

4. Below is a brief introduction for creating the video wall.

A. Extend the content to all devices or set each device to play the same content mode.
B. Set the resolution for each device. You can also customize the resolution yourself.
C. Decide the Panel Area, H (Horizontal) x V (Vertical).

D. Assign each display's position in the video wall.

E. Enable Compensate function for BenQ Smart Signage's display margin.
Setting (DemoRoom_430_videowall)

Name demo_room_videowall
\ Mode
A: i BeInQ o
B
Screen Resolution(One Screen) 1920% 1080 ~
)
G Area 1~ 3
)

Device Position

4301 v  430M v  430R -
group.video_wall_margin_setting_hint

Ef Compensate Disable Unit: mm (Entera
J

@ Enable(Unitmm) @  Visual area setting: Width = 194¢  Height 535

Margin setting : Top | 12 Bottom | 18 Left | 12 Right 12

Fine Tune  FDEPXNJX,-39,0
UBIGHWLL,0,0
VRRAXRHE,0,0

Cancel Destroy

5. After all configuration is set, click Confirm.
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6. Set one Android box for installing VideoWallController apk. Then put the Android box and all
displays in the same subnet.

7. Select VideoWall Devices info, and you will see all devices for video wall on the list.

8. Now you can use the video wall channel to schedule for playing the content.
Channel Management

a
Type ~ Channel name
Video Wall DemoRoom_430_videowall
Normal Unsubscribed 5
Normal 12345 0
Normal bobby
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How to create the video wall content from X-Sign Designer
With X-Sign Designer, you can easily create content for the video wall display.

I. Create a new project.

X 2
=
Fle Edt lnsen  Amange  View  Prewiew  Help  Local Delivery

" o mmm

| |
I
i

Open Project New project Interactive template Local delivery

Demo Video

2. Below is a brief introduction for video wall setting.

A. You can set the display in landscape or portrait mode.
B. You can choose the resolution of each display.
C. This shows the Panel Area (Horizontal x Vertical).

D. This shows the simulation of the video wall and the overall resolution.
TS

Hl  D:\X-Sign project

!
Project name videowalltest B)

A ® Landscape (O Portrait
r

Single screen resolution  1920x101 w

r_J
) Panel Area @ w X1 =

D -

Video wall resolution: 5760x1080

Confirm

3. After all configuration is set, press Confirm.
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4. Now you can start to design your video wall content.

XJ X-Sign Designer - DAX-Sign projectivideowalltestscenexmi *
File  Edit Insert Arange View Prewiew Help  Local Delivery

*

7 videowallost | NewPage (1) -+ LSRN = -
Basic Tools Layer

@ @ object1 (Image)

Ton s

o Rectrgie

.....
Property -
Page I
Name New Page (1)
Duration 10:00.000
Resolution 5760x1080 Modﬁyl
Panel Area 2
Background -I
Color #FFFFFF
image

Add Del
Image Style Fill
Transitions
Effect None:
Duration Very Slow
5760 x 1080 X:2775  Y:-763 + 2% - O P
S .t

How to get the device warning notification

You can enable Warning Letter Settings to get the system notification of your devices from X-
Sign Manager.

I. Go to Advanced Application > Warning Letter Settings.

2. Enable Warning Letter notification.
Available space - 100 GB

D Warning Letter Settings

+ File

» My Faioik |Waming Letter notification: n FEI HecaIaT +
YRR 1

bobby.y.chen@beng.com
~ Advanced Application

Queuing System

I ‘Waming Letter Settings

*  License Management

About

Then you will get notice when your device is under the following situations.

* When the device time can’t sync with the Manager system time, the device can’t play content
normally.

a. It is highly recommended you enable auto time sync service on your device.
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b. Make sure to set the same location on both Manager and the device.

[X-Sign System Notice] Unable to play due to unusual device
status

Dear I

Please kindly be advised that your device(s) with current schedule are in the abnormal
status now and may be not able to play the content correctly.

Device name Category Device status
fises i e | Uncategorized Error - Time Error
Regards,

X-Sign Manager Service Team

* When the device is under schedule but not online, the device can’t play content normally.

[X-Sign System Notice] Unable to
play due to unusual device status

Dear BEtuy=anm,

Please kindly be advised that your device(s) with
current schedule are in the abnormal status now and
may be not able to play the content correctly.

Device name Category Device status
e ] BQT Offline
Regards,

X-Sign Manager Service Team

* The device license is going to expired.

Ma x-Sign

The following device already expired today:
Device Name

Dear I

Display ID
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* Press == to add more receivers. The default will be the administrator only.

Available space : 100 GB

‘

Device

File Management
My Favour
W&

Advanced Application
Queving System
Warning Letter Settings

License Management

About

Warning Letter Settings

Warning Letter notification: n T E

+ Add email

E-mail

1
bobby.y.chen@beng.com

BenQ X-Sign 2.0

125



	BenQ X-Sign 2.0
	Basic
	How to register an account for X-Sign Manager
	How to access your account
	How to set the permission for users
	How to purchase the license from X-Sign Manager
	How to import the license(s) to X-Sign Manager
	How to import Local Delivery license in Windows Player
	How to pair the signage with X-Sign Manager
	How to upload your content from Designer
	How to create the channel
	How to schedule the content in the channel
	How to play the content to single or multiple devices in different channel
	How to push Real-Time Message to your BenQ Smart Signage remotely
	How to edit the device management structure
	How to control BenQ Smart Signage remotely
	How to update device Player remotely
	How to switch the mode of Player
	How to play files with USB
	How to create a new project file in X-Sign Designer
	How to open an X-Sign 1.6 project file
	How to create content in X-Sign Designer
	How to create content from Designed Templates
	How to create an Image or Video slideshow
	How to rotate an image or video
	How to set background music in X-Sign Designer
	How to change the playing order of pages
	How to activate an Interactive function in Standalone mode
	How to generate a QR Code
	How to add a data connection
	How to set a weather widget
	How to set a timer widget
	How to manage the calling system

	Local Delivery
	How to play content with Local Delivery
	How to search for devices in Local Delivery Mode
	How to set a schedule for Local Delivery Mode

	Report
	How to get the device information remotely
	How to get the activity report of X-Sign Manager
	How to see the QR Code analysis report

	Interactive
	How to create interactive content with Interactive template
	How to create interactive content from designed templates with Area Link
	How to view the structure of an Interactive Template
	How to enable Interactive Statistics
	How to view an Interactive Report

	Video Wall
	How to set up the environment for video wall
	How to create the video wall content from X-Sign Designer

	Security
	How to get the device warning notification





